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 1.3. References Description  

o 2. PC Requirements  
 2.1. Minimum Hardware Requirements  
 2.2. Supported Operating Systems  

1. About the N1MM Logger Documentation 

This revised documentation, initially released in May of 2011, is organized in three main sections:  

 

1.1. Getting Started Description 

Getting Started is intended to guide the new user in chronological order to the point where he/she has 
a correctly installed version of N1MM Logger with basic logging functionality.  

 

1.2. Digging Deeper Description 

The Digging Deeper section will provide in-depth information for configuring and operating N1MM 
Logger, beyond what is covered in Getting Started. The information in Digging Deeper is arranged by 
topic areas.  

 

1.3. References Description 

The purpose of the Reference section is to provide a location for information not directly related to 
supporting the N1MM Logger software - but still information that users will find useful.  

2. PC Requirements 

2.1. Minimum Hardware Requirements 

N1MM Logger has been designed to run satisfactorily on a 1 GHz Pentium III with 512 MB of memory. 
You may encounter performance problems when running minimum configurations and operating CW or 
RTTY modes, when receiving a high volume of cluster spots, or when your PC is simultaneously 
running several other applications. It has not been and won't be a priority to make N1MM Logger run 

on clunkers, but the developers are very interested in finding and correcting the causes of 
performance problems when they occur.  

The recommended minimum graphical resolution is 1024 by 768, with many hams running higher 
resolutions and dual screens. Although N1MM Logger will operate at 800 by 600, you may find that 
you want more windows open than will fit conveniently on one screen. One trick in this case is to 



overlap windows with enough showing so that you can click on them only when needed to bring them 
to the foreground.  

Radio control, CW keying and PTT can be done through serial or parallel ports, through a USB-to-serial 
adapter, or through K1EL's Winkeyer (an excellent solution which offloads CW processing entirely). For 
PTT with MMTTY an extra serial port is needed.  

SO2R "boxes" may be controlled through a hardware LPT port under 32-bit operating systems, and 
under 64-bit operating systems if a substitute port driver is installed as described here. Alternatively, 
the MicroHam USB SO2R Control Protocol and the K1XM Open Two Radio Support Protocol are both 
supported, for use with devices that accommodate them.  

USB-to-serial converters and USB interface devices are supported through virtual serial ports 
provided by their associated driver software. USB-to-LPT converters cannot be used for either SO2R 

control or CW/PTT functions, except for the PIEXX SO2RXLAT  (which is specifically designed for this 
purpose).  

For more information see the Interfacing section.  

2.2. Supported Operating Systems 

 Windows XP  

 Windows Vista 32/64  

 Windows 7 32/64  

 Windows 8 32/64  

 
Linux and other Operating Systems will not be supported.  

 

1.2 Downloading the Software 

 1.2 Downloading the Software  
o 1. Download sites  
o 2. Full Install  
o 3. Latest Update  

1. Download sites 

To improve performance and avoid the risk of a single-location website failure, the N1MM Logger files 
can be downloaded from two locations:  

Primary download site: n1mm.hamdocs.com/tiki-list_file_gallery.php   

Alternate download site: n1mmfiles.k8ut.com/tiki-list_file_gallery.php   

To download a brief video tutorial on downloading and installing the program, click the icon below  

 
Download video  
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2. Full Install 

Installing N1MM Logger for the first time requires that you download two files - the Full Install and the 
Latest Update. The Full Install file changes infrequently, whereas the Latest Update file changes often, 
sometimes more than once per week.  

Locate the Full Install file on the download site under the menu selection >Files >Full Install. Save the 
file, named N1MM-FulIInstaller.exe, to your download directory or the desktop of your PC.  

3. Latest Update 

 

Locate the Latest Update file on the download site under the menu selection >Files >Latest Update. 
Save the file to the same location where you saved the Full Install file.  

 

You only need one Latest Update file! 

Each Latest Update file includes the improvements and fixes from all of the preceding files. It is only 
necessary to download and install one Latest Update file — usually the most recent — to create a 
completely up-to-date version of N1MM Logger 

 

Filename Convention for Latest Updates 

The syntax for naming Latest Update files is N1MM-newexeVYY.MM.NN.exe, where YY is the Year, 
MM is the month of the year, and NN is a sequential number assigned to updates beginning each 
month with 00. For example, Latest Update file N1MM-newexeV11.09.04.exe would be the 5th 
update released in September of 2011. 

 

1.3 Installing and Upgrading N1MM Logger 

 1.3 Installing and Upgrading N1MM Logger  

o 1. First-Time Installation Instructions  
 1.1. Installing under Vista, Windows 7 or Windows 8  
 1.2. Windows Settings that may affect program operation  
 1.3. Beginning the Installation  

 1.3.1. Installing the Latest Update  
 1.4. Using the Program the First Time  

 1.4.1. Edit Station Information  

o 2. Subsequent Installation of the Latest Update of the Software  
o 3. Moving the Program to a New Computer  
o 4. Uninstalling the Program  

1. First-Time Installation Instructions 

 
Please Note - These instructions apply both for first-time users and for users who are jumping from a 
very old version to the current one. That is, if you previously installed Version 9.x.x (or earlier) and 
want now to update to the latest and greatest, then you need to go through this process before you 

install the Latest Update. In particular, this is needed to update the files used for recording and 
playback of .wav files.  



1.1. Installing under Vista, Windows 7 or Windows 8 

By design, the current default installation location is C:\N1MM Logger, not C:\Program 
Files\N1MM Logger as was the case under Windows XP. This is because recent versions of Windows 
do not allow user programs to write within the Program Files directory or its subdirectories, whereas 

N1MM Logger was designed to store the program and all its associated data in the program directory. 
Various methods have been tried to overcome this restriction in Windows, but by far the simplest and 
most foolproof method is simply to avoid installing the program within the Program Files directory. 
Other methods of running the program from within the Program Files directory may appear to work, 
only to result in subtle file access problems that aren't evident until some time later, such as an 
inability of Windows Explorer to find the files written by the program. To avoid these problems, do 
not install N1MM Logger in the Program Files or Program Files(x86) directories under 
Windows Vista, Windows 7 or Windows 8!  

It is perfectly all right to change the default directory during the initial install, as long as you 

remember to stay away from Windows protected directories like C:\Program Files and C:\Program 

Files(x86). For example, you might want to create a directory called C:\Ham Radio, and place N1MM 
Logger and other amateur radio programs in their own sub-directories within this directory. Once you 
have done the initial installation, the installer for future upgrades will remember where you installed 
the program. However, once the program has been installed into a given location, you cannot change 
that location by simply copying the program files to a new location; you must uninstall and reinstall 
the program to ensure that the move from one location to another will be fully successful.  

When you start the Full Installer or subsequent Latest Update installers, right-click on the filename 
and select "Run As Administrator." Once the program has been installed and updated, it can be run 
from a restricted or guest account if you prefer to set your computer up that way.  

 

Avoiding Security Problems During Installation 

N1MM Logger uses a number of .dll and .ocx files - for example, inpout32.dll, is used as its interface 

to LPT ports, and n1mmv5wav.ocx powers the audio recording and playback functions. Various 

security provisions in Windows, as well as various after-market security software, can prevent the 
installation or registration of these files  

A few simple steps can work around these problems. First, download the Full Install and Latest Update 

installers to a regular (non-temporary) directory on your hard drive. Then when you run the Full 
Install, right-click on the filename and select Run as Administrator. This is necessary even if your User 
account has Administrator privileges.  

Once you run the Full and Latest Update installers as an Administrator, the needed .dll and .ocx files 
should all be properly registered. If you are using the parallel (LPT) port for CW, PTT or antenna 
selection, you will also need to run the program itself for the first time as an Administrator, so that 

some internal file-shuffling can take place. This should not be necessary thereafter - just run as usual 
from a desktop icon or shortcut. 

1.2. Windows Settings that may affect program operation 

 
There are some default settings in Windows that can affect the way the program operates. To avoid 
problems, it is suggested that you change these settings. Note that these changes are in Windows, not 
in N1MM Logger.  

The first has to do with USB hubs (ports). The Windows default behaviour for USB hubs is to shut 
them down to save power after a period of inactivity. Unfortunately, the only activity Windows appears 
to be aware of is keyboard or mouse activity. A USB port that is being used for something else, such 



as a USB-to-serial adapter, looks to Windows as if it is inactive, and Windows shuts that USB hub 

down after a few minutes. This will cause the port to stop working, and if you go into the Configurer to 
make changes, the program will be unable to open the port when you exit the Configurer.  

The solution to this is to open Device Manager, expand the section on Universal Serial Bus controllers, 
and then for each and every entry labelled either "Generic USB Hub" or "USB Root Hub", open its 
Properties dialog window, select the Power Management tab, and uncheck the check box called "Allow 
the computer to turn off this device to save power".  

 

Windows Power Management Settings 

The following additional tips on power management settings that can affect program operation come 

from Joe, W4TV (thanks, Joe!):  

In addition to the hardware settings for hubs in Windows Device Manager there are other important 

settings in the Power options (Control Panel). All of these settings will not apply to every system, but 
every system running N1MM Logger or any other logging software should be set to minimize Windows 
"power saving", not sleep, not hibernate, and not disable any peripherals while plugged in (you are 
"plugged in" while running N1MM Logger, aren't you?).  

Open the Control Panel and select Power Options. One of the "Plans" will be "High Performance" - 
select it. Then click "Change plan settings" and set "put the computer to sleep" to "never" (at least 
when plugged in). Also select "Change advanced power settings" and set "Sleep | "Hibernate after" to 
"Never" and "Allow hybrid sleep" to "Off". In "USB Settings" set "USB selective suspend setting" to 

"Disabled" and under "PCI Express" set "Link State Power Management" to "Off". Also set "Wireless 
adapter Settings" to "Maximum Performance".  

These settings should prevent the computer from going to sleep, shutting down USB ports and 
disabling the network interface when it is plugged in - when you want to keep background tasks 
running. 

 

Here is another tip that has nothing to do with power management, and does not actually affect 
program operation, but may have an impact on your ability to find some of the N1MM Logger files. In 
Windows Explorer, under the Tools option, select Folder Options. Click on the View tab, and look down 

the list for a check box called "Hide extensions for known file types". The default for this option is 
checked, but we suggest unchecking this option. If you leave it at the default, you may have trouble 
finding files referred to either in the documentation or by people giving help instructions on the user 
group. For example, both N1MM Logger.exe (the actual program) and N1MM Logger.ini (the 
configuration settings file) will be called simply N1MM Logger in Windows Explorer, and you may have 
trouble telling which is which. Unchecking this option will make the full file names visible in Windows 
Explorer.  

Regarding Windows time settings, we do not recommend setting your computer to UTC. Instead, set 
your computer to your correct time zone including the correct DST setting, set the computer's time to 

match your local time, and Windows and N1MM Logger between them will take care of the rest. You 

can even operate straight through the daylight savings time switch in March or November (e.g. during 
Sweepstakes CW) and while you will see your computer's time display change by an hour at 2 am if 
you look closely, N1MM Logger will not skip a beat; it will log all of your contacts with the correct UTC 
time.  

1.3. Beginning the Installation 

Download the Full Install here.  
Run the installer  

http://n1mm.hamdocs.com/tiki-index.php?page=Full+Install


 

 

 
 
 

 
Next, you will be asked to agree to a straightforward, freeware license.  



 
 
 

 
Next, you will be given a choice of files to install, which looks like this.  



 
 
 

 

If you are running a 64-bit computer, refer back to the note above and don't check DLPORTIO. You 

also do not need to check DLPORTIO if you are not planning on using a version earlier than 11.10.0 
(October, 2011). If you plan to use an older version of N1MM Logger (prior to October, 2011), and 
use parallel port(s) for CW, PTT, or SO2R control, and you are running a 32-bit operating system, the 
DLPORTIO port driver must be installed.  

In the next screen, note that the default location for installation of the program is C:\N1MM Logger. 
This is new, and was done in order to work around operating system restrictions that caused problems 
for users with Vista or Windows 7. If you have previously installed N1MM Logger, for instance in 
C:\Program Files, the default location will not be used; instead, the last previous program directory 
will appear here.  



 
 
 

 
When you click Install, the Full Installer will  

 Install all needed files on your computer to run N1MM logger  

 Update your system files where needed  

 
You will find that certain parts of the Full Installer installation routine take quite a long time. The 
installation program has not failed, so just let it run to completion. Subsequent updates are much 
faster.  

 
 
 

 

Do Not Overwrite Newer System Files 



When running the Full Installer your computer may report that certain system files are already 

installed on your system and are newer than the ones you are trying to install. It asks if you want to 

replace a newer, existing file with an older file in the Full Install. Select 'No'. You do not want to 
overwrite newer system files. 

 

After the installation process is complete, if you have opted to install DLPORTIO, you will be invited to 
install it as a separate process. Just follow the on-screen instructions.  

1.3.1. Installing the Latest Update 

The first time you try to run the Full Install version of the program, you will be prompted by a 
message like this to update to the latest version.  

 

 

Where is the program installed? 

For version 9 and before, the default installation location was in C:\Program Files\N1MM Logger. 
Because this caused inconvenience for users of Vista and Windows 7, beginning with Version 10 the 

default location is C:\N1MM Logger. If you are making a first-time installation of the Version 10 Full 

Install, the installer will automatically choose this default location. You can change the location, but it 
is strongly recommended that wherever you change it to should not be inside Program Files. 
Thereafter, during subsequent updates the update installer should point to the same place. Some 
users have chosen to ignore the recommendation and continue to install to Program Files, and a few 
of them have reported that the update installer does not remember the initial installation location in 
this case. As you can imagine, putting the Full Install in one place and updates in another can cause 

all sorts of problems. It's worth checking to ensure that the update installer is proposing to install the 
update in the correct location.  



 

Click the button at the bottom of the window to go to the web page, and download the latest version 
you find there. Run the updated version installer, and follow its simple steps to get fully up to date. 
The update will take less than 2 minutes to install.  

If you are installing N1MM Logger on a computer that does not have internet access, you will need to 
download the latest version from a computer that has internet access, rather than clicking that button. 

This procedure is described in Subsequent Installation of the Latest Update of the Software. After 
downloading the latest version, copy and install it on the non-internet computer.  

 

1.4. Using the Program the First Time 

1.4.1. Edit Station Information 

 The first thing to do after starting the program is to enter your station information. This dialog 

will open automatically with your first launch of N1MM Logger. For subsequent updates, select 
Change Your Station Data from the Config menu in the Entry window.  

 
Your Station Data dialog will be similar to this one. Note: a "dialog" is simply a window in which 
you can enter information. The term is often used interchangeably with "window" in this 
documentation.  

 

http://n1mm.hamdocs.com/tiki-index.php?page=Installing+the+Software#Subsequent_Installation_of_the_Latest_Update_of_the_Software


 

 

 

The information in this dialog is self-explanatory, but it is very important that it be accurate. For 
example, In order for the program to calculate accurate beam headings, you will need to put your 
longitude and latitude into the appropriate fields. Also make sure that you enter your call as the 
station call sign. Don't leave any example entries that may be there at start-up.  

Many of the fields in this dialog are used when creating contests or during contests.  

 ARRL Section and the State field are used in some contests and QSO parties to determine if 

you are in or outside a state or province. Non-US/VE stations should enter "DX" here.  

 Latitude and Longitude are used to calculate the distance and bearing to another 
station/country (for HF contests)  

 For VHF contests (those with VHF in the contest name) the Grid Square field (4 or 6 digit) 

in the Station dialog is used to determine bearings, rather than latitude and longitude.  

 Contents of the Latitude and Longitude fields update when the Grid Square field is changed 

and vice versa.  

 Club normally has to be spelled out completely in order for it to be accepted by contest 
organizers in contests with a club competition, so enter Yankee Clipper Contest Club rather 

than YCCC (don't let Tom be a bad example!).  

 E-mail address and SMTP server address are used for sending bug reports via e-mail. Your 
e-mail address and SMTP server address can be found in your e-mail program.  

2. Subsequent Installation of the Latest Update of the Software 

 

Update philosophy 

Many of us are used to always being "one version behind" in our software use, in order to avoid bugs 

that may have been introduced in the latest version. But because N1MM Logger is updated so 
frequently (typically, on Tuesday of every week), the opposite is true. You are always encouraged to 
use the latest version — in general, bug reports and feature requests should always be made after 
checking to make sure the latest version does not already include the bug fix or feature that you want. 

An e-mail will be send out periodically to announce new versions (updates) of the program to the 
Yahoo reflector members.  

Download only the N1MM-newexeVx.x.xxx upgrade file. Use the link contained in the announcement 

e-mail to the Yahoo group, or open this web page  and select the update you want. if you have not 
updated for a while, you do not need to install any of the intermediate versions - just go right to the 
latest. The only exception might be updates that are marked as "Experimental" or otherwise explicitly 
marked as not for general use. These are very rare.  
The upgrade file contains the latest .exes and other necessary files  

Run this installer and let it copy all the program files into the N1MM Logger program directory, 
replacing any old versions.  

3. Moving the Program to a New Computer 

 
The easiest and best approach is:  

1. Copy your entire N1MM install directory (where ham.mdb is) and subdirectories to C:\N1MM 
Logger, or any directory other than Program Files or Program Fkles(x86) on your new 
machine. This will make sure that your old logs and settings are all carried forward, and that you do 

http://n1mm.hamdocs.com/tiki-list_file_gallery.php?galleryId=15


not lose any needed files in the transition. If you're thinking about putting the new installation in 

Program Files, please read this discussion first.  
2. If you have not yet done so, run the current Full Installer, and use the directory you chose above - 
the default is C:\N1MM Logger - as the install directory.  

3. Install the latest update, which can be found here, in the same directory.  
4.Rename the old N1MM Logger.ini file (to N1MMLogger.old, for example). This will cause the program 
to create a new, almost-empty .ini file.  
5. Once these steps are completed, run N1MM Logger.exe. The program will create a new .ini file. 
Then rebuild your configuration.  

It may be tempting to use your old .ini file, but the chance of problems is great. Port numbers, port 
addresses, sound card numbers and other hardware-related items in the .ini file will probably be 
different on the new machine. It is a lot easier to make those changes in the Configurer than using 
Notepad and editing the old.ini file.  

 

4. Uninstalling the Program 

 

If you are thinking of uninstalling and reinstalling the program in order to fix a problem you have 
encountered, you should know that this is rarely the solution. The majority of problems encountered 
by users are configuration problems that are not resolved by uninstalling and reinstalling in the same 
location. Instead, try looking at the Troubleshooting section, where you will find suggestions for other, 
less drastic methods.  

However ... if you want to uninstall N1MM Logger entirely, including any registry entries, the best way 
is to navigate to the program directory and find the program cleverly titled UninstallN1MM.exe. Run 
the uninstaller and follow any prompts you see.  

 

1.4 Digital Installation and Setup 

 1.4 Digital Installation and Setup  

o 1. Downloading and Installing MMTTY  
o 2. Downloading and Installing Fldigi  
o 3. Setting Up the Configurer  
o 4. Learning More  

Setting up an interface involves configuring the Logger for the selected interface. Configuring has to 
be done within N1MM logger in a few places, including the Configurer ( Config >Configure Mode 
Control, Audio, Other) as well as the Digital Interface window. If you are using MMTTY for FSK RTTY, 

you will also have to perform some configuration from within MMTTY. If you use Fldigi, there is some 
configuration that must be done from within Fldigi.  

Before you can use MMTTY, you will have to download and install it. Likewise, before you can use 
Fldigi, you will have to download and install it. This process is described in the next two sub-sections. 
You do not need to download or install any additional files or programs to use MMVARI or a TU/TNC.  

A brief note about hardware connections for sound card digital modes (using MMTTY, MMVARI or 
Fldigi). These depend on the radio, the sound card and the interface (if any) in use, and it is 
impossible to cover all of the possibilities in detail, but the following general comments apply.  

http://n1mm.hamdocs.com/tiki-index.php?page=Installing+the+Software#Installing_under_Vista_Windows_7_or_Windows_8
http://n1mm.hamdocs.com/tiki-list_file_gallery.php?galleryId=15
http://n1mm.hamdocs.com/tiki-index.php?page=Troubleshooting


First, you must have some means of connecting the radio's audio output to the sound card's input. 

The ideal connection would be from a fixed-level ("line out") output on the radio to a "line in" input on 
the sound card. If your radio has one receiver, this will probably use the left channel of the sound 
card; with dual receivers, the second receiver may use the right channel. If your sound card does not 

have a line level input, you may need to use a microphone input, and in this case you may need an 
attenuator to reduce the line level output from the radio to the lower level needed for the microphone 
level input on the sound card.  

To transmit, there must be some means to convey modulation from the computer to the radio. For 
FSK RTTY, this is an on-off keying signal, which is normally generated by a serial port connected to 
the radio's FSK keying input through a simple keying circuit. This serial port cannot be the same port 
that is used for radio control or for a Winkeyer or other serial device. If it is a USB-to-serial adapter, 
you will probably need to use MMTTY's EXTFSK plugin. If you are using MMVARI for RTTY using FSK 
keying, select the appropriate plugin (FSK8250 for true serial ports, EXTFSK for USB-to-serial 
adapters) in the Configurer under the Digital Modes tab).  

For AFSK RTTY and for all other sound card digital modes (e.g. PSK31), there must be a connection 

from the sound card's output ("line out", or speaker or headphone output) to the radio's audio input. 
If the only audio input on the radio is a microphone input, you may need attenuation to reduce the 
level to avoid overdriving the transmitter.  

You also need some means to control TX/RX switching (PTT). The most common method is to use 
hardware PTT control from a serial or parallel port via a simple keying circuit. Hardware PTT can be 
controlled either from the digital "engine" (MMTTY, MMVARI or Fldigi), or from N1MM Logger itself. To 
use serial port PTT from the digital engine, you must use a different port from the one that is used by 
the Logger for radio control. If you have a serial port set up for FSK keying, you can use a control line 
(RTS or DTR) on this same port for PTT control from the digital engine. If PTT is controlled from a 

digital engine rather than from the Logger, you should check the Digital box for that serial port in the 
Configurer and make sure to indicate the appropriate Dig Wnd Nr (1 for DI1, 2 for DI2).  

If you do not have a separate serial or parallel port available for PTT in digital modes, you can control 
PTT directly from the Logger. For example, if your radio control interface supports PTT using RTS or 

DTR on the radio control serial port, you can configure the Logger to use this method. If no method of 
hardware PTT control is available and if your radio supports PTT via radio command, you can use 
software PTT control from the Logger. Warning: Using both software and hardware PTT control at the 
same time can cause problems; do not use both methods in parallel.  

As an alternative to hardware and software PTT control, you may be able to use VOX. This does not 
work with all radios, it cannot be used for FSK RTTY, and setting of audio levels and VOX triggering 
levels can be tricky, but some users have found this to be the simplest method of PTT control, since it 

does not require any additional hardware connections. Some external interfaces (e.g. SignaLink) 
perform a VOX function external to the radio, i.e. they generate a hardware PTT signal based on the 
presence of an audio signal without any connection to a serial port on the computer. If you are using 
such an interface, or VOX within the radio, you do not configure any PTT in the Logger or in the digital 
engine, as PTT control in these cases is external to the software.  

1. Downloading and Installing MMTTY 

 
MMTTY is not installed as part of the installation of N1MM Logger. It must be downloaded and installed 

separately. It is possible to use N1MM Logger in RTTY without using MMTTY (e.g. by only using an 
external TNC, or AFSK RTTY from MMVARI). If you intend never to use MMTTY, you can skip the rest 
of this section. However, most RTTY users will probably want to have the ability to use MMTTY, at 
least as an option. In particular, if you would like to make use of the additional RX windows for 
"diversity decode", you will most likely need to install MMTTY (unless you have several TUs/TNCs you 
can use for the purpose).  



If you do not have a copy of MMTTY, then before continuing with the digital setup it is recommended 

that you download a copy of the MMTTY installer from the MM HamSoft website . You can find a 
copy of the full installer for the current version of MMTTY at that website. This file is a self-extracting 

executable, similar to the N1MM Logger installer. Download the file to a temporary folder and then 
execute it. It is recommended that you install MMTTY in its own program folder and not in the N1MM 
Logger program folder. By default, the installer will install MMTTY to C:\Program Files\MMTTY\ . If you 
are using Windows Vista, 7 or 8, this is not likely to be where you want it to be installed. We suggest 
that you create a folder outside the protected Windows program files path, e.g. C:\MMTTY\ or C:\Ham 
Radio\MMTTY\, and install MMTTY there.  

If you already have a copy of MMTTY installed on your computer, you can use that copy from N1MM 
Logger. However, if you also use MMTTY stand-alone, it is possible that you may want (or need) to 
have a different setup for stand-alone use than with N1MM Logger (e.g. if you use the radio control 

port from within MMTTY stand-alone; this is not possible when MMTTY is used with the Logger). If you 
need a different setup with the Logger than the one you use stand-alone, then you should create a 
separate folder for each copy (for example, you can create a sub-folder inside either the N1MM Logger 

program folder or the MMTTY program folder for the second copy of MMTTY). You need to copy only 
the MMTTY.exe and UserProfile.ini files from the main MMTTY folder into the additional folder (plus the 
extfsk.dll file if you are using EXTFSK for FSK keying). MMTTY will create a separate copy of MMTTY.ini 
when it is run.  

If you plan to use two copies of MMTTY in SO2V or SO2R mode, one for each received audio stream, 
you will need to create two copies in separate folders with different configurations. In SO2V, one of 

these copies can be configured to use the left channel and the other copy to use the right channel of a 
single sound card. In SO2R, you can either use a stereo sound card as in SO2V, or you can use two 
separate sound cards, one for each radio.  

If you want to use MMTTY for diversity decoding in additional RX windows, you will need to create 
another separate sub-folder for each additional RX window. For example, you can create sub-folders 
called DI1, DI2, DI1RX1, DI1RX2, DI2RX1 and DI2RX2 so that you can run up to six copies of MMTTY 
simultaneously; one for each main DI window, plus up to 4 additional RX windows (two additional 
windows for each DI window). Into each of these windows, you need only copy the MMTTY.exe and 

UserPara.ini files from the main MMTTY program folder created when you first installed it. Each copy 

will then be configured to use the appropriate sound card and channel. The "Additional RX" copies use 
the same sound card and channel as the parent copy in the main DI window, but they can be 
configured to use different decoding algorithms or profiles to give you "diversity decoding", i.e. two or 
three different decoding methods used on the same receive audio.  

Note for users of Windows Vista and Windows 7: User Account Control (UAC) in these versions of 
Windows prevents user programs from writing configuration information into the Program Files path. 
Even if programs are run with Administrator privileges, UAC may interfere with the ability to use 
separate configuration files for separate copies of the same program. Therefore, it is suggested that 
the folders for the extra copies of MMTTY used in the two DI windows and the four RX windows should 

not be in the Program Files path. It is suggested that you create a new folder outside the Program 
Files path, such as C:\Ham Radio\MMTTY, and then place the individual sub-folders for the separate 
copies of MMTTY within that folder.  

Once MMTTY has been downloaded and installed, you can proceed to use the Configurer to set up 
N1MM Logger to use it.  

2. Downloading and Installing Fldigi 

 
FLdigi is not installed as part of the installation of N1MM Logger. It must be downloaded and installed 
separately. It is possible to use N1MM Logger in RTTY and PSK contests without using Fldigi. Fldigi 

http://hamsoft.ca/pages/mmtty.php


supports a wide range of other digital modes, but most of these are rarely used for contesting. If you 
intend never to use Fldigi, you can skip the rest of this section.  

If you do not have a copy of Fldigi, then before continuing with the digital setup it is recommended 
that you download a copy of the Fldigi installer from the W1HKJ website at 

http://www.w1hkj.com/  . You can find a copy of the full installer for the current version of 

Fldigi at that website. This file is a self-extracting executable, similar to the N1MM Logger installer. 
Download the file to a temporary folder and then execute it. It is recommended that you install Fldigi 
in its own program folder and not in the N1MM Logger program folder. By default, the installer will 
install Fldigi to C:\Program Files\Fldigi-x.xx.xx\, where x.xx.xx is the Fldigi version number.  

Note that Fldigi cannot be configured to use a single channel of a stereo sound card; Fldigi always 
uses its sound card in mono mode on receive. If you want to use Fldigi in a two-receiver configuration, 
either SO2V or SO2R, you will have to use two separate sound cards. You will also need to install two 
separate copies of Fldigi in separate folders, one for each DI window, in order to be able to configure 
each one for a separate sound card. It is suggested that you do a full install for each copy, but do not 

create Start menu or Desktop shortcuts for the second copy. As with MMTTY, users of Windows Vista 
and Windows 7 may find it necessary to install one or both of these copies outside the Program Files 
path.  

You do not need to install separate copies of Fldigi for additional RX windows, because this feature is 
not implemented for Fldigi or MMVARI engines, only for MMTTY and hardware TUs/TNCs.  

3. Setting Up the Configurer 

 
There are three tabs in the Configurer that need to be set up when configuring N1MM Logger for 
digital modes. The first is the Hardware tab, where serial ports used for digital modes are set up. (If 
you are using VOX or an interface that performs the VOX function externally (e.g. SignaLink), you do 
not need to configure a port for digital modes under this tab.)  

http://www.w1hkj.com/


 

 Checking the Digital box in the main Configurer window indicates to the Logger that this port 
is used for digital mode control.  

o Use this to indicate a port that is used for an external TNC  
o Use this to indicate a port that is used for FSK keying with MMTTY  

 A port that is used for FSK must also be configured inside the MMTTY setup. 
This includes ports used with EXTFSK  

 It is possible to use a port in the range COM9-COM16 for FSK with MMTTY. In 
this case, there is no Digital box to be checked; the port must be configured 
entirely within MMTTY  

o Use the Digital box to indicate a port that is used for PTT in AFSK RTTY or other 

digital modes with MMTTY, MMVARI or Fldigi  
 Exception: If PTT is done from a radio control port or from a Winkeyer, do not 

check the Digital box for that port  
 It is possible to share a port for both serial port CW keying (e.g. on DTR) and 

for PTT and FSK using MMTTY for RTTY (e.g. on RTS and TxD of the same 

port). In this case, check both Digital and CW/Other for that port. When in 
CW mode, the settings in the DTR and RTS boxes will determine how the port 

is used; in RTTY, it will be the settings in MMTTY that determine how the port 
is used  



 

 

In the Set window for each of these serial ports, the radio and the DI window associated with the port 
is configured.  

 The Radio Nr box indicates which radio this digital interface is for in SO2R mode; in SO2V and 
SO1V, Radio Nr is always = 1  

 The Dig Wnd Nr indicates whether this port is used for DI1 or DI2. This applies to SO2V and 

SO2R; in SO1V, Dig Wnd Nr is always = 1  
o You must choose a Dig Wnd Nr for each port that has the Digital box checked; 

otherwise the program will not assign the port to a DI window!  

 
The next tab to be set up is the Digital Modes tab.  



 

 MMTTY (if used)  
o Digital Interface 1/2 (left part of window)  

 TU Type: Soundcard  
o DI-1/2 MMTTY Setup (upper right part of window)  

 MMTTY Mode: Select AFSK or FSK  
 MMTTY Path: Select path to MMTTY.EXE  

 The path does not need to be in the N1MM Logger program directory  
 The paths for the two DI windows do not need to be the same  

SO2V/SO2R in MMTTY 

You can use MMTTY with both receivers in a two-receiver setup with a single stereo sound card. You 
will need to install two copies of MMTTY in two separate program folders in order to allow one copy to 
be configured to use the left channel of the sound card and the other copy to be configured to use the 

right channel of the sound card. 

 MMVARI (if used)  
o Digital Interface 1/2 (left part of window)  

 TU Type: Soundcard  

o DI-1/2 MMVARI Setup (bottom part of window)  
 MMVARI RTTY Mode: Select AFSK or FSK  
 FSKPort: (FSK only)  

 Choose FSK8250 if you are using a true serial port or a device that 
can simulate a serial port and handle 5-bit codes at low speeds (this 
does not include most USB-to-serial adapters, but it does include 



some commercial interfaces designed to support FSK RTTY as well as 

some multi-port USB-to-serial adapters)  
 When MMVARI is opened for FSK RTTY, a small window 

labelled MMVARIFSK1 1.04 will open, or appear on the 

Windows Task bar. In this window you select the COM port 
number and the signal line to be used for PTT (RTS or DTR). 
FSK keying will be done on the TxD line. If this is a USB device 
that simulates a serial port, check Limiting speed. You can 
use the _ box at the top right to minimize this window after 
completing the setup  

 FSK8250 supports all of the RTTY speeds supported by 

MMVARI and the selected COM port or device  
 Choose EXTFSK if you are using a regular USB-to-serial adapter  

 When MMVARI is opened for FSK RTTY, a small window 
labelled EXTFSK 1.06 will open, or appear on the Windows 
Task bar. In this window you select the COM port number and 
the signal lines to be used for FSK keying (normally TxD) and 

PTT (RTS or DTR). You can use the _ box at the top right to 
minimize this window after completing the setup  

 The only RTTY speed supported by EXTFSK is 45.45 baud  

SO2V/SO2R in MMVARI 

You can use MMVARI with both receivers in a two-receiver setup with a single stereo sound card. In 
the DI Window's Digital Setup dialog box under the MMVARI Setup tab, simply configure the DI1 
SoundCard to use the left channel and the DI2 SoundCard to use the right channel. 

 Fldigi (if used)  
o Digital Interface 1/2 (left part of window)  

 TU Type: Soundcard  
o DI-1/2 Fldigi Setup (lower right part of window)  

 Fldigi Path: Select path to fldigi.exe  
 The paths for the two DI windows do not need to be the same  

SO2V/SO2R Limitation in Fldigi 

There is a basic limitation in the Fldigi engine which can make it harder to use in dual-receiver 

situations (SO2R and SO2V). Fldigi always receives in mono mode. If you are using a stereo sound 
card to decode two receivers, with one receiver in the left channel and the other receiver in the right 
channel, Fldigi will combine the two receivers in its waterfall. It doesn't matter whether Fldigi is the 
interface engine in DI1 or DI2, it will see the audio from both receivers.  
Therefore, if you want to use Fldigi with both receivers in a two-receiver setup, you will need to use 
two separate sound cards for the two receivers. You will also need to install two copies of Fldigi in two 

separate program folders in order to allow a different sound card to be configured in each copy. 

 External TNC (if used)  
o Digital Interface 1/2 (left part of window)  

 TU Type: Other  

 Set other parameters appropriately for the TNC in use (Example settings: 
9600, 8, N, 1, Xon-Xoff)  

 

The third tab to be set up is the Mode Control tab, which determines what mode the radio will be set 
to use in RTTY and PSK.  



 

The available choices in the list boxes under Mode sent to radio will depend on the particular radio 
type (see Supported radios). For FSK RTTY, the correct choice will normally be RTTY. For AFSK RTTY, 
depending on the radio the appropriate choice might be AFSK or LSB/USB. For PSK and other sound 
card modes, the radio mode would be PSK (if available), AFSK-R (on some radios) or USB on most 
radios. 

The setting under Mode recorded in log can also vary between radios, and even between contests. 
Especially if you are using the radio's USB or LSB mode to do sound-card digital modes including AFSK 
RTTY, the Logger may have difficulty knowing whether you want to operate in SSB or in a digital 

mode, and if a digital mode, which one. The choices on this side of the Mode Control window are 
intended to help with these situations, but there is no one set-and-forget setting that will cover all 
cases. You may find yourself having to change this setting between contests, for example. For more 
information, see the Configurer page under the Config >Mode Control tab.  

4. Learning More 

If your principal interest is in the digital modes, you may want to jump from here to the Digging 
Deeper explanation of digital features.  

 

1.5 Interfacing Basics 

http://n1mm.hamdocs.com/tiki-index.php?page=Supported+Radios#Digital%20Information
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 1.5 Interfacing Basics  

o 1. Operating without an Interface - Manual Mode  
 1.1. Entry Window when Operating in Manual Mode  
 1.2. Special Keystrokes for Manually Setting the Log's Band and Mode 

Information  
o 2. Basic Radio Control Interfacing  
o 3. Interfacing for Phone, CW and PTT  

 3.1. Phone Interfacing  

 3.1.1. Interface Hardware  
 3.1.2. Phone software setup  

 3.2. CW Keying and PTT Control  
 3.2.1. CW Messages  

1. Operating without an Interface - Manual Mode 

There are many reasons why you could find yourself operating in manual mode. Maybe you're just 

getting started and have not had time to install and configure an interface? Perhaps your radio does 
not support PC integration? You have a computer but it lacks the necessary I/O ports to connect a 

radio? Or maybe you're operating from a short-term portable location and don't have the time or 
equipment to connect the radio to the computer? Whatever the reason, there are special keystrokes 
that you need to enter in the Entry Window to inform N1MM loggger of the band and mode that you 
are operating. Without entering these instructions, your log will contain inaccurate QSO information.  

1.1. Entry Window when Operating in Manual Mode 



 

 

1.2. Special Keystrokes for Manually Setting the Log's Band and Mode 

Information 

1. Type frequency changes in the callsign field and press <Enter>. If you want 
the log to only indicate the band, and not specific frequency information, enter 
the frequency of the bottom of the band in kHz (note that some contest 
administrators request that manual frequency entries always be bottom of 
band). For example: 7000 for 40 meters, 21000 for 15 meters. If you want the 

log to include the actual frequency, enter the complete frequency in kHz. For 
example 14025.1 (or 14025,1 if your computer uses comma as the decimal 
separator). The new frequency should appear in the title bar of the Entry 
Window.  

2. Type mode changes in the callsign field and press <Enter>. Mode settings can 

include CW, SSB, RTTY or PSK. The new mode should appear in the title bar of 
the Entry Window.  

 
For more details about these commands, see the Entry Window Text Commands in the Digging Deeper 
section of this documentation.  

2. Basic Radio Control Interfacing 

http://n1mm.hamdocs.com/tiki-index.php?page=Entry+Window&structure=N1MM+Logger+Documentation#Entry_Window_Text_Commands


Regardless of whether you want to operate phone, CW or digital modes, the most useful and 

important interface is the one between your computer, N1MM Logger and your radio. Fortunately, 
most radios now incorporate a serial port to enable them to swap information and commands with the 
computer.  

A first step is to look up your transceiver in the manual section titled Supported Radios. Assuming you 
find your radio there, look for any specific settings or peculiarities that need to be addressed and 
make a note of them.  

USB is rapidly replacing both RS-232 serial ports and LPT parallel ports. If your radio has a standard 

RS-232 serial port, once you have purchased a USB-to-serial adapter and installed the drivers for it, 
N1MM logger can work with your radio just fine. If your radio uses either Icom's CI-V standard or 
another non-RS-232 serial port, you'll need an appropriate converter cable to get from either USB or 
RS-232 to your radio.  

Some USB adapters, particularly those using a Prolific chip-set, are erratic with programs written in 

Visual Basic. If you encounter quirky performance or an 8020 error, that's probably what you have 
got. See the Error Messages section of Digging Deeper for details on this error, and USB Interface 
Devices for a full rundown on user experience with various specific adapters.  

Radios are starting to appear now with USB ports. If yours is one of these, check the Supported 
Radios entry for your radio (and the radio manual) to find USB interfacing details.  

 

Avoiding Problems with USB Ports Going to Sleep 

One of the most frequently-encountered problems with USB ports is making sure that they don't go to 
sleep just when you need them most. You should disable all "power-saving" affecting USB ports, but 

this requires some digging.  

 

In either Windows XP or Windows 7, get into Device Manager  

http://n1mm.hamdocs.com/tiki-index.php?page=Supported+Radios
http://n1mm.hamdocs.com/tiki-index.php?page=Error+Messages
http://n1mm.hamdocs.com/tiki-index.php?page=USB+Interface+Devices
http://n1mm.hamdocs.com/tiki-index.php?page=USB+Interface+Devices
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Then click on the "+" sign to the left of Universal Serial Bus controllers.  



 



Click on each of the USB Hubs in turn.  

 

On each one, click on the Power Management tab, and uncheck the box titled "Allow the computer to 
turn off this device to save power."  

Unless you really need to save power, we also recommend turning off the overall system power-down 
features under "Power Options." 

Once you have the hardware hooked up between your computer and your radio, start N1MM Logger 

and open the Config menu in the Entry window. Choose Configure Ports > Telnet Address, Other. 
Ignore all the other stuff for now.  



 
 
 

 

That brings up the following, rather intimidating dialog. Don't worry, we'll walk you through the part 
you need now.  



 
 
 

 

You may want to select SO1V if this is your first experience with N1MM. SO1V allows N1MM to control 
VFO A in your transceiver. If you are an experienced contester and understand how to operator in split 
mode (for example, working DX on 40 meter sideband) you may want to select SO2V. It allows N1MM 
to simultaneously control both VFO A and VFO B in your transceiver. If you are an advanced contester, 
whose station is configured with TWO transceivers (one for running contacts and the other for 
searching for new multipliers), then you will want to select SO2R.  

Now identify which port you have physically connected between your computer and the radio (or in 
the case of USB, the virtual serial port it has created). Click the drop-down arrow under Radio, and 

select your specific radio model. For this example, I've assumed COM3 and a Yaesu radio. Virtually all 

Kenwood models use the one common radio configuration, while Yaesu and Icom radios are generally 
designated by the specific model number - refer to the manual under "Supported Radios" for more 
information. Icom radios require a Radio Address (Hex Code) - see the manual for more information.  

Now click the "Set" button next to the port you have chosen.  



 
 
 

 

That will bring up this dialog, with connection details. Normally, N1MM Logger chooses the parameters 
in the first two rows for you, and does a good job. You might want to verify them with your radio 

manual, just in case. Radio/VFO number should be 1, so that your main VFO will be displayed in the 

main (first) entry window. The rest of the stuff on this dialog is not important right now, so just click 
OK to get back to the previous dialog, and then OK again to return to the Entry Window.  

If all is well (you did turn your radio on, right?), when that big multi-tabbed dialog closes and the 
Entry Window reappears, the title bar of the Entry Window will display the radio's frequency and 
mode. It's magic. The "+0.00" simply means that RIT is turned on, but set to zero (no offset)  



 
 
 

 

Now that you have radio control, you can do a lot of neat things, but one of the most basic is that you 
will never again have to worry about accidentally logging QSOs on the wrong band or mode.  

3. Interfacing for Phone, CW and PTT 

Of course, controlling your radio through a serial port isn't the only way to interface N1MM Logger and 
your radio - in fact, long before there were computer-controllable radios, the pioneering logging 

software authors developed several standards for CW and PTT interfacing, using either serial or LPT 
(printer) ports.  

We'll start, though, with a discussion of phone interfacing, on the theory that this will be of most 
interest to new users. Once you're interfaced, you will be able to store voice messages and play them 
back through your radio, to save your voice during phone contests.  

3.1. Phone Interfacing 

3.1.1. Interface Hardware 

There are two levels to this - the physical interface and the software setup. Physically, you will need to 
connect your microphone to the Microphone In jack on your sound card, and provide an interface 
between your sound card's Line Out jack and the microphone jack on your rig. This can be as simple 
as a 10:1 voltage divider (the Line Out signal level is much higher than your radio's microphone jack 
is designed for) and isolation transformers (to avoid feeding AC hum into the sensitive microphone 
jack on either your sound card or your rig). You can also use any of the commercial interfaces.  

Here's a simple schematic  



 
 
 

3.1.2. Phone software setup 

Now, on to the software setup, which is where most people seem to have trouble. The following 
discussion is cribbed almost verbatim from audio trouble-shooting notes by David Robbins, K1TTT. If 
any mistakes have crept in, blame the manual team, not him.  

To begin with, make sure you close Windows Media Player, RealPlayer, Audacity, or any other sound 
playback/recording program you may have open. Start N1MM Logger. On the Config menu, open 
"Configure Ports, Mode Control, Audio, Other", also known as the Configurer.  



 

Now select the Audio tab. As shown here, select option 1 "Only use Radio 1 Output Device. Output on 
both channels." Assuming that your sound card is designated in Windows as the default device, select 



"default" in the first "select device" list:  

 

From the drop-down lists in "Tx Sound Card Setup", make sure that the Radio 1 Output Device is 
correct for your sound card. The Port to Mute will usually be set to Microphone, because its purpose is 

to mute the microphone when you are transmitting a stored voice message. Then make sure that the 
Message Recording Device is correct, and that the Message Recording Port is set to Microphone. Make 
sure the Recording Sample Rate and the Recording Bits number are set to values supported by your 
sound card.  
Now OK out to save these settings, and close N1MM Logger.  

Plug your microphone directly into the microphone jack on your sound card. Plug your headset directly 
into its speaker output. Open the Windows Volume Control. It should come up with a set of sliders. In 
Windows XP, they look like this:  



 
 
 

 

Or this, in Windows 7, after you finally drill down through the options on the Control Panel, under 
Sounds  

 



:  

Fortunately, in Winsdows 7, all you have to do is make sure the microphone isn't muted, and that the 
top slider is set at about mid-range. If you are using a typical ham dynamic microphone, such as a 
Heil, you will probably need the full 20 dB boost on the second slider.  

 

Sound Cards Are Weird 

Unfortunately, sound card manufacturers have added a dazzling number of bells and whistles the past 

few years, including software-configurable input and output ports and other gadgets that affect 
recording. We have to leave you a little on your own here. The important thing is to find the 
microphone recording volume control, make sure it is selected, and that the level is about 50 percent.  

 

In Windows XP, you may have to go into Options|Properties to check the box to let you see the 
microphone volume control and those for other sound sources. Under Options>Properties, click the 
'Recording' radio button, and make sure the microphone is checked on the list of controls: In Windows 

7, just make sure the mute button is not pressed.  

 
 

 

 

In Windows XP, make sure the Microphone slider is at mid-range and that there is a check in the 
Select box. If you are using a typical ham microphone, such as a Heil, and you have the "Advanced" 
button, click on it and select Mic Boost if that option is available, because it provides a 20 dB preamp. 
Now OK out.  



 
 
 

 

Now, when you talk in the microphone, you should be able to hear yourself in the headset. If you 
can't, then something is wrong with your settings, hardware or drivers. Try playing existing .wav files 
using the Windows Control Panel's Sounds option. Recheck volume and mute settings, check that the 

microphone is plugged into the right jack, try a different microphone, try a different headset. DO NOT 
PASS THIS POINT UNTIL YOU CAN HEAR YOURSELF!  

Now open Windows Sound Recorder, which is usually found in the Accessories category in your 

program list. DO NOT open Audacity, any of the audio tools that came with your sound card, or your 
other favorite tool. Some of them play with the mixer settings and we don't want that now that they 
are set. These are for windows XP and Windows 7, respectively.  

 
 

 

 

 

Click the Record or Start Recording button in Sound Recorder, and speak a few words into the 
microphone. You should see the level indicator deflect in time with your voice. Now press Stop. Press 
the Play button and you should hear what you just said. If you don't there is something wrong with 



your hardware or drivers. Check recording control settings, adjust volume, make sure the microphone 

is selected as the recording source, and get that 8 year old back to help again! DO NOT PASS THIS 
POINT UNTIL YOU CAN RECORD AND PLAY. If Windows Sound Recorder doesn't work, then N1MM 
likely won't work and since N1MM is much more complicated it is harder to troubleshoot.  

If it's working OK, now close the Sound Recorder and start N1MM Logger. Put the program in Run 
mode (Alt+U or click in the Running box) and your radio on USB or LSB, and make sure that the Entry 

Window's title bar specifies either USB or LSB (if you don't have a radio connected, type the 
appropriate mode in the callsign box and hit <Enter>).  

Right-click on any of the message buttons in the entry window. That will bring up the Function Key 
message editor:  



 

Don't be intimidated - we're just going to use this screen to set up a single function key to send a 
single message, so we can check out the entire flow from pressing a Function Key to having an audio 
message properly sent to your radio. The filenames and remarks you see in the editor now are the 

default filenames that are put into the table when you first install MM. If this is not your first time 
using N1MM Logger, these may not be the first ones you see. the full story on the message editor, see 
this page in Digging Deeper.  
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For test purposes, we are just going to use one message, in the slot for Run F1. This is the message 

that will be sent when the program is in Run mode and F1 is pressed. This is intended to be the 
location for your CQ Message. If the editor shows "F1 CQ,CQ.wav" in the first row of the Run Messages 
section, then you're ready to go. Just close the window with the X in its upper right.  

 

The Difference Between "Save" and "Export" 

There is a critical difference between the "Save" and "Export" buttons in the bottom frame of the 

Function Key Message Editor. If you click "Save", the currently-displayed contents (including any 
changes you have made) are saved in your current database, for use the next time you press a 
function key. They are also written to the file-name shown in the upper frame of the editor. 
To save a change on the fly and get back quickly to using the program, all you need to do is click Save 
and then X in the upper corner to leave the editor and return to the Entry Window. However, if you 
want to retain the file that was loaded into the editor in its original form - as you might want to with 

the default files, for example - then you must first click Export, select a filename in the Save Macros to 
File dialog that opens, and then click Save. Then, you must click Save in the Function Key 

message editor to load the edited function keys into the current database. 

 

Now, make sure you are in Run mode - that is, that the Run checkbox in the Entry Window is checked. 
Now watch the bottom line of the Entry Window (called the Status Line) and press Ctrl+Shift+F1. You 
should see:  

 

 

One important thing to note here. If you have not entered your callsign under change Station Data on 
the Config menu, you will not see your callsign in the status line. This is important - stop, go do that, 
and then repeat this step.  

If you speak into the microphone at this point, whatever you say will be recorded in the file CQ.WAV 
under WAV\<your callsign>.. Press Ctrl+Shift+F1 again (or ESC) to stop the recording, and look for 
this report in the same place:  



 

Now press F1. You should hear what you just recorded in the speaker. If you don't, make sure you're 
still in Run mode and look for an error message in the Status Line. We suggest using the 
Ctrl+Shift+Fx process to record within N1MM Logger, at least until you get truly comfortable with 

audio files, because a lot of the problems people run into are a result of recording with diofferent 
programs, or in filenames that are different than the program expects to see.  

Now that you've got things working, you need to program at least the first few function keys. It's best 
to follow the order in the example above, at least for F1-F8, because a little later, when we talk about 
ESM (Enter Sends Messages) mode, the order is important. Be sure that each Function Key message 
line begins with the Function Key number, a brief label (like CQ), a comma, and the content of the 
message  

OK, so now you have everything you need to play "canned" audio messages on the air. If you're 

content to use VOX to switch your transmitter, and you're not interested in CW, then you can stop 
here, for now.  

3.2. CW Keying and PTT Control 

Common Misconceptions 

N1MM Logger supports several methods of CW keying, but two are not supported. The first is CW by 

audio tone, or MCW, as is done by software such as FLDIGI, The reason for this is that this method 
can produce unnecessarily wide signals, or even in some cases two closely-spaced signals from one 
transmitter  

The second method involves sending ASCII characters to the radio, which then converts them to CW. 

Only a few radios have this capability, and in most or all of these the resulting CW operation is far less 
suited to contest use than N1MM Logger's own.  

A full discussion of interfacing is in the Interfacing section of the manual.  

 
In its simplest form, CW is sent and PTT is controlled by switching lines on a COM or LPT port. This 
technique allows the simplest possible interface, but one is required. Here's a block diagram of the 
COM port setup. For LPT port keying, a USB adapter will not work. Your computer must have a 
hardware LPT port:  
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Please note that only a very few radios permit CW and PTT via their built-in serial ports. The rest 
require that the interface be plugged into the CW key jack on the transceiver. The exceptions to this 
are covered under Supported Radios.  

The interface can be anything from the simplest - one resistor and one transistor - to one of the many 
units on the market that handle both CW and various digital modes.  

Let's assume you're going to use this method to start with. Begin by opening the Config menu to the 
Ports, other dialog:  
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Your dialog will show COM ports 1-8 and LPT ports 1-3, regardless of which ports are actually (or 
virtually) there. For this example, let's choose COM1 as our CW/PTT port. Put a check in the CW/PTT 
box and you'll notice that the Set button is no longer greyed. Click on it, and open the dialog for that 
port.  



 
 
 

 

You can configure the DTR pin as either CW or PTT. Click the down arrow and you'll see the list of 
possibilities:  

 
 
 

 
Highlight the one you want, depending on your interface. Now do the same with the RTS pin:  

 
 
 

 

You'll note that the choices are different. This is because commercial interfaces generally do not use 
RTS for CW, while many default to RTS for PTT. If you are building your own . Just make sure you 
plug the correct one into the key jack.  



 
 
 

 

Set the Radio/VFO Nr to 1. The PTT Delay setting is to protect the relays in an amplifier by making 
sure that the T/R relay is closed before the program starts sending CW. The default value of 30 Ms. is 
fine even if you don't have an amplifier.  

Unless you know that you have your COM1 at a non-standard memory address, assume that N1MM 
knows best and accept the default address it suggests. If it is a USB virtual port, this setting doesn't 

matter anyway.  

OK, now to interface to the rig. The very simplest interface imaginable will work just fine for either the 
CW or PTT functions with any modern radio; again, there are many commercial options, but here's the 
Radio Shack parts solution:  

 
 

 

3.2.1. CW Messages 

 
From the Tools menu, select Change CW/SSB/Digital Message Buttons, and then Change CW Buttons.  



 
 
 

 
That will bring up this window.  



 

What it is displaying is the default function key message file that is now shipped with each update of 
N1MM Logger. There is much more on the Function Key Message Editor here, but for the moment, let's 
use what we find already in place.  

Going down from the top, note the macro {MYCALL}. An alternative to this is the single-character 
macro *. Either one denotes your callsign, from the Station Data window. This is a text macro. There 

are two types of macros, text macros and action macros - text macros substitute a string of text for 
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the macro, while action macros perform some program action. Both are often used in combination 

with regular text in a message, as shown here - when you press the function key or click the on-
screen F1 button, the program will send CQ TEST N4ZR N4ZR TEST (substituting your call for the 
asterisk). There's a table of the many recognized ((Function Keys, Messages and Macros|Macros)) in 
the chapter by that name in Digging Deeper but for now let's go on.  

Conventionally, F2 is used for your contest exchange. The sample file uses the {EXCH} macro, which 

is a text macro that substitutes whatever you put in the Sent Exchange part of your Contest Setup. 
Say, for example, we were setting up for a contest where the exchange is signal report, your name 
and your state. When N4ZR sets up the contest, he puts PETE WV in the Sent Exchange. Now when he 
presses or clicks F2, the program will send PETE WV.  

Also in Run F2 is the macro {SENTRSTCUT}. Many of us just put 5NN explicitly in F2, but this macro is 
a little cleverer. It sends the signal report (nominally 5NN) but substitutes whatever cut number style 
you choose in the Configurer here.  
One fine point - you might think of putting the 5NN in your Sent Exchange - after all, everyone's 599, 

right? Well, don't, because it will screw up your Cabrillo log. Just resign yourself to putting 5NN or 
{SENTRSTCUT} wherever you want it sent.  

The next handy trick to notice is in Run F5, where ! is used. That always denotes the other station's 
call, grabbed from the Entry Window  

A final tip - most macros are in the form of {WORD}, where "word" is the macro. The curly brackets 

are necessary so that the program knows it's time to substitute something or take some action. It is 
awfully easy to type a square bracket or common parenthesis instead of the curly bracket, so look 
carefully.  

From now on, if you want to change the content of any message buttons, there's a shortcut - just 
right-click in the area of the buttons, and the editor we just left will reappear.  

OK - you've hooked up your interface, so now you're ready to send some canned CW. As explained 

above, you can either hit the function key F1, or click on the F1 button. Either way, the program will 
switch your radio from Receive to Transmit (assuming you have PTT connected - you can also use VOX 
or break-in, of course) send the message, and then go back to Receive again.  

There are two easy ways to adjust the speed of your CW - either click the up and down arrows next to 
the CW speed box (where it says "30" in the picture above), or press <Page Up> or <Page Down>, to 
increase or decrease speed in 2 word per minute increments. If you hit the wrong key or button, no 
problem - hit the <Esc> key to stop sending immediately.  

 

If you want to send CW manually, the easiest way is to 

parallel a keyer with the computer CW at the transceiver's key jack. Alternatively, hit Ctrl + K, and a 
CW window appears:  

Type the CW you want, and hit Enter when you're done. As soon as you begin typing, the program 
begins sending; you can type ahead, and the program will finish sending the CW before the window 
closes.  

 

1.7 Learning Your Way Around 
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 1.7 Learning Your Way Around  

o 1. The Entry Window  
o 2. The Check Window  
o 3. The Log Window  
o 4. The Bandmap  
o 5. Logging Essentials  

Take a few minutes to learn your way around the four windows that you need to make your first 
contest QSOs with N1MM Logger. Additional information about each window will be found here.  

1. The Entry Window 

Let's get a little terminology out of the way first. The top blue part of this (or any) window is called the 
Title Bar. Each of the places where you can type information is called a textbox. The Title Bar displays 
the current frequency, mode (if one has been selected), and which radio it is (nominally, Radio A). You 

will have to enter a mode before you begin to operate, and a band and/or mode each time you change 
either. Simply type a frequency in KHz (3500, 7000, etc.) in the Call-Sign textbox (to the far left) and 
hit Enter; then type a mode (CW, USB, LSB) there, hit Enter again, and you're set.  

The Entry Window is your main starting place for everything you do with N1MM Logger. The first row 
is a standard Windows-style menu, and we'll be using it in a minute. Take a moment and explore the 
various drop down menu choices, but don't change anything right now.  

Below the menu is a set of entry textboxes. This row is where you log your contest QSOs. The left-
most textbox is the Call-Sign textbox. You always enter the call-sign of the station you are working 
into this textbox.  

 
 
 

 

The rest of the data entry textboxes are titled above them - depending on how you have resized the 
window, the titles may not line up perfectly with the entry textboxes, but they are always in the same 
sequence as those textboxes. Depending upon the specific contest and the required contest exchange, 

the number of textboxes and the titles may be different. The example Entry Window shown above 
would be used during the IARU Contest. This contest requires a call sign, sent and received signal 
reports, and the IARU Zone be logged for each contact  
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For now, you can ignore the 'Running' check-box, as well as the rest of the buttons alongside it. This 

controls one of the most important features of N1MM Logger - it distinguishes between Run and 
Search and Pounce modes, providing different features for each. However, these aren't really relevant 
until you get into sending stored CW and phone messages, which are covered in Chapter 4. The rest of 
the buttons in the Entry Window are related to this, and to other advanced capabilities.  

If you want to save space on your screen, you can reduce the size of the Entry Window, like this. Just 
use your mouse to grab the lower right corner or lower edge of the window and drag it upward.  

 
 
 

 

There are two more useful features of the Entry Window. The box in the lower left corner, called the 
Status Line, provides a lot of useful program status information. For example, if you enter a call sign, 
the Status Line will tell you what country it represents. If you have set up the Entry Window just a 
little bigger than the minimum, it will also show you the distance and bearing, like this.  

 
 

 

 

To the right of the Status Line is the progress box, where you can keep track of your QSOs and 
multipliers without having another window open, and to its right is a running score.  

If you press the backslash (\) key (and the program is in SO2V or SO2R mode), the program opens a 
second, almost-identical entry window. The only difference is that it will have a "B" instead of the "A" 
in the title bar of the first entry window, and it may well have a different frequency and/or mode as 



well. But if you pop up the second Entry Window by mistake, and want to get rid of it, you simply 
close it by clicking the big red X.  

When you first open the program, it will be in SO2V (Single Operator Two VFOs) mode. The idea is 
this - most modern transceivers have two VFOs, or a main VFO and a sub-VFO. There will be 
circumstances - during a contest on 40 meter SSB, for example - when you will want to receive on 
one frequency and transmit on another, widely-separated one.  

For the moment, you should probably change to SO1V (Single Operator One VFO) mode. Select the 
Config menu, and under the dropdown menu, select Configure Ports, Telnet Address, Other and then 
click on the SO1V button. This will prevent the second Entry Window from opening.  

 
 

 

 
The Entry Window is the nerve center of N1MM Logger. It is the only window with a formal menu bar, 
and the program returns focus to this window automatically in many situations.  

2. The Check Window 



 
 
 

OK, another important window - the Check window. You open it by clicking on Check in the Entry 
window;s Windows menu. You can set the font with a right-click menu choice.  

This window is used to display the results of checking a call-sign against your log and also against a 

master list of calls, variously called the master.dta or Super Check Partial file. One is provided when 
you install the program, and the process of updating is covered in the Tools Menu section of Digging 
Deeper.  

First things first, though. When you type a call-sign in the Entry Window, the Check window displays 
whether a match was found or not. If the match is in your current log, it is shown in the first line of 
the window, like this: 

 
 
 

 
Note the program warns you that you have already worked that station, and can't do so again on the 

current band (or maybe in the entire contest, like SS). Also note that two lines below are two possible 
matches from the master database.  

Had the station you copied been W1AWB, when you entered the Check window would change to 
reflect that, as follows: 
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Note that the station's call appears in blue, meaning that to work the station would not be a new 
multiplier, but would be a valid non-dupe QSO. This color coding is consistent throughout the 

program. Because it appears in the second row, you know that it is from the database and not from 
your log (if for example, you had worked him on another band, the call would appear on the first line, 
in blue).  

There is much more on the Check window, including an alternative way of looking up calls called 
"N+1", here.  

3. The Log Window 

To begin with, click on Log in the Entry window's Windows menu. That will open a Log window on the 
screen, like this:  

 
 
 

 
First, you should notice that the title bar of the Log Window gives the current date and exact time, the 
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name of the contest, and the database in use. As you log QSOs, they will appear in the log. One is 

logged one above just to indicate how it looks. The most recent last QSO is highlighted. You'll note 
that each column has a fixed label - these labels do not change. CQWW is a 2-multiplier contest, so 
the log shows columns for "Mult" which is the country, and "Mult2" which is the CQ Zone. The "yes" in 
each simply means that it is the first of that multiplier on that band.  

If you click on any column heading, the entire log is sorted by that attribute - for example, if you click 

on the Mult heading, the log will be sorted so that all of your first QSOs with a given kind of multiplier 
(in this case, a new country) will be moved up to the front. Click on TS (for timestamp) to switch back 
to the normal log order.  

A further nice touch - if you click a second time on the column heading, for example the "Call", the 
sort order switches from Ascending to Descending, so that all your "Z" QSOs come first, and your "As" 
last. Same goes for the TS (TimeStamp) heading - normally, you'll want to leave the Log Window in 
TS ascending, so that each QSO you log appears immediately at the bottom of the list.  

The Log window has two "panes" the one above the dark-grey line is the normal log, while the one 
below the line is to show you previous QSOs with a station, each time you type its call into the Entry 
Window. This makes it very easy to see, quickly, all the information about previous QSOs, for that 
special someone who drops by and asks, "What was the serial number you gave me yesterday?"  

Check out this section of Digging Deeper for more details.  

Like all windows in N1MM Logger, the Log window is resizable, as are the individual log columns - to 
resize the whole window, use your mouse to drag the lower right corner, and to resize a column grab 
the between-column divider and drag it right or left. You can move any window around the screen by 
dragging its title bar. Also, as I mentioned above, you can change the font in the Log window by right-
clicking in the window, and choosing your font as you did for the Entry window.  

4. The Bandmap 
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With an interfaced radio, you will find it useful to open a Bandmap window. Click Window, then select 
Bandmap, and the Bandmap corresponding to your entry window will be displayed.  

In the example at left, I have filled the Bandmap with spots from a packet cluster, just to illustrate 
how spots are displayed. The stuff in the top bar is pretty self-explanatory. The SH/DX button, when 
mouse-clicked, sends that request to the cluster (which you don't know how to set up yet). The button 

labeled Wide toggles filters in your radio, though you may have to set it up first (the process is 
explained in the manual). In any case, clicking on it switches TO the filter mode shown. The red RIT 



means that RIT is on, and the number left of it is the amount of offset. The black XIT means that XIT 
is not selected. Turn on XIT and you'll see it turn red.  

The color-coding of spots in the Bandmap is the same as in the Entry Window, so each of those red 
calls represents a new multiplier in the contest. If you want, you can mouse over a spot, and the 
program will tell you more about it.  
The "-635 min" tells you how long ago the spot was posted. Generally, you won't want to keep spots 

displayed that long, and a little later I'll explain how to clear spots after a certain amount of time has 
elapsed.  

 

In a busy contest, certain parts of the band can get pretty crowded with spots. Pressing the numeric 
keypad <+> key will zoom the Bandmap in and spread the spots out, like this:  

 
 
 

 

Pressing the numeric keypad <-> key will have the opposite effect. You can also zoom the Bandmap 
using the scroll wheel on your mouse, if it has one.  

Another useful thing about the Bandmap. If you single-click on a spot, your radio will automatically be 

sent to that spot. If, instead, you click on the frequency scale (anywhere within the width of the 

frequency hash marks), the radio will go to that frequency. There are also keyboard shortcuts that will 
move your radio from spot to spot up and down the band. More on this later.  



 
 
 

 

When you single-click on a spot, something else useful happens - the call-sign of that station is copied 
to the Call-Frame of the Entry window, like this. This is done this way so that if you discover that the 
station on that frequency isn't OK1XJ after all, you can just type in the correct call. This does happen 
now and then with packet spots.  

However, let's assume it's OK. In that case, all you have to do is call the station, get him to answer 

you, and hit <Space>. Here's what happens - the call sign is pulled down into the Call-sign field, and 
the QSO is all set for logging, once you complete the exchange.  

 
 
 

 

Another good thing can happen on the band-map when you complete a QSO and tune off the 



frequency - the spot's color code turns to grey, so that you know at a glance that you have worked 
the station already, and won't waste time when you come back to that frequency again.  

 
 

 

 

To turn on this feature, click Config, and then, in the dropdown menu, click on the two items checked 

(see below). You need them both because grey spots are regarded as non-workable, and they will 
disappear unless Show non-workable spots is checked. If you don't work a station, and tune off his 
frequency, his call sign will appear in the appropriate color to denote whether he's a new multiplier or 
simply a valid QSO; either way you know to go back and work him later, if he's still there.  



 
 
 

 

By the way, even if you never plan to use packet spots, the Bandmap is a very useful window. As you 
S&P your way up and down the band, each station you've worked will be marked with a grey self-spot, 
so you can skip by them the next time even if you have no packet spots.  

You may be wondering how to move quickly up and down the Bandmap, hitting only the workable 
spots, or those that represent multipliers. This might be a good time to introduce another very useful 

section of the Manual. N1MM Logger makes extensive use of "hot-keys" to largely or entirely eliminate 
the use of the mouse during contest operations. There is a very useful section in Digging Deeper titled 
Key Assignments (Keyboard Shortcuts) which explains each and every such key combination. For 
example, under "Active Radio/Bandmap Key Assignments" it lists:  

Jump to Spots Note: If you are operating single mode, your mode won't change when jumping 
between spots.  

 Ctrl+Down Arrow - Get next spot higher in frequency.  
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 Ctrl+Up Arrow - Get next spot lower in frequency.  

 Alt+Ctrl+Down Arrow - Get next spot higher in frequency that is a multiplier.  

 Alt+Ctrl+Up Arrow - Get next spot lower in frequency that is a multiplier  

Try these and see - with a full Bandmap and these keystrokes, it is easy to work 100+ search and 
pounce QSOs per hour, something that used to be regarded as impossible.  

As we're finishing up this introduction to the Bandmap, it might be a good idea to offer another 
general hint when you're exploring the program. Be sure to right-click on each new window (other 

than the Entry Window), to see what options involving that window might be available to you. Each of 
these options is explained in the section of the manual dealing with that window.  

If you do this with the Bandmap, you'll see this right-click menu:  

 



 

 

 

Of the choices here, Packet Spot Timeout is perhaps the most useful. Click there and set the timeout 
interval in minutes - both self-spots and spots from packet will disappear after however many minutes 
you choose.  

 
 
 

 
The Reset Radios command is also useful in case, for some reason, you lose control of your radio. 
Click it, and the program resets the connection.  
Check here for much more.  

5. Logging Essentials 

This listing pulls together a dozen (or so) keyboard commands that are essential in N1MM Logger. It 

was originally prepared by Rich, VE3KI to help a club planning first-time use of the program on Field 
Day  

General  

 Esc : stop, exit, abort, back out of whatever you are doing  

 
Logging  

 Spacebar or Tab : move between exchange elements  

 Enter : log a completed valid QSO  

 Ctrl+Alt+Enter : log an incomplete/invalid QSO with a note in the log  

 Ctrl+N : add a note to the log  

 Ctrl+O : to enter the operator's name or call sign (or type OPON in call sign field) - optional, 
use to keep track of who was operating when  

 Alt+W : wipe whatever is entered so far (Alt+W again to undo the wipe)  

 
Changing logged contacts  

 Ctrl+D : delete last QSO from log  

 Ctrl+Q : Quick Edit last QSO  
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o while in Quick Edit (blue background), use Ctrl+Q to go to earlier QSO in log, or 

Ctrl+A to go to later one  
o Enter to accept changes, Esc to abort and return to logging  

 
Changing current frequency & mode  

 To change modes, type CW or SSB or RTTY or PSK into Entry window, hit Enter - or, if your 
radio is interfaced for radio control, just change modes on the radio  

 To change frequency, type the frequency in kHz into the Entry window, hit Enter - or, if your 
radio is interfaced for radio control, change frequency on the radio  

 
CW/SSB/Digital (needs CW keying interface/voice keyer/Digital interface respectively)  

 Alt+U : switch between Run & S&P mode and messages  

 F1 : send CQ message and switch to Run mode  

 F4 : send your own call sign (S&P)  

 ; key or Ins : send his call sign + exchange message (F5 + F2)  

 ' key : send TU and log QSO (F3 + Enter)  

 = key : re-send last function-key message  

 Alt+K : edit current function-key message buttons  

 Ctrl+K : ad lib keyboard CW/digital text (use Enter or Esc or Ctrl+K to end)  

 PgUp/PgDn : CW speed up/down  

 

 

1.6 Setting Up for a Contest 

 1.6 Setting Up for a Contest  

o 1. Setting Up for a Particular Contest  
o 2. Trying It Out  

1. Setting Up for a Particular Contest 

Now that you have set up the hardware interfaces to your radio, including radio control (often called 
CAT), PTT, CW, etc., let's move on to setting up for a particular contest.  

Note that the first database the program creates is named ham.mdb by default - you can have as 
many databases as you want, and name them what you want. I'm using ham.mdb, but my program 

directory is named MM Beta (for historical reasons). Some people prefer to create a database for 
every contest, while others create one for a period of time, like every year. If you want to create a 

database, for example "2007.mdb", just click Files to drop down the menu, and then click on "New 
Database".  



 
 
 

 
That will open a standard file creation dialog in your program directory  



 
 
 

 

Name your new database and click Save. You'll be switched to the new database and ready to go.  

Back to the Files menu again. This time click "New Log in Database: C:\Program Files\N1MM 

Logger\ham.mdb" A new dialog opens, called the Contest Setup Dialog.  



 
Beginning with release 12.05.04, this dialog has two aids to completing it properly, the buttons 
labeled "Show Rules" and "Show Setup". Show Rules takes you (via Internet) to the sponsor's web 
page, while Show Setup takes you (again via Internet) to the Contest Setup page, located in the 
Digging Deeper section of the manual. Typically, the latter will give you what you need to fill in the 
Contest Setup dialog.  

The first thing to do is to click on the down button of the Log Type field. That will open a list of 
abbreviated contest names, as I already have done above. You can use your mouse to scroll through 
the list, or type the first letter of the contest to jump to the right general area. Once you have found 
the contest you want and highlighted it, click back in the original field and the drop-down list will 



close.  

 

When you set up a new contest, the Start Date defaults to the current date. This can be useful if you 
have several versions of a given contest in your database. Once you have selected a contest, it gets a 

little more interesting. Year to year, dates of contests change, but the day of the week usually 
remains the same. For this reason, the program assumes that the contest will actually start 
on the correct day of the week (and time of day) following the Start Date entered in the 
Contest Setup Dialog. For example, if you set up a new contest on Wednesday, to start at 0000Z on 
Saturday, the program assumes that will be the actual start time, for purposes of computing time on 
or off the air, and for displaying any goals you have set in the Info window.  

To avoid confusion, it is best to set up the log you will actually use within a week before the start of 

the contest. You can always use a practice version earlier. So long as it is in the same database, you'll 
be able to set goals, set up your function keys and other associated files, and all of this will be 
available for use when you set up the "real" log. Just delete the practice log and you're ready to go.  

Next, fill in the information in the next few fields, denoting the class and category you intend to enter 

in the contest. In each case, you have drop-down lists available. "Overlay category" refers to contests 
like WPX, which have both regular classes and categories like Rookie or "Tri-bander plus wires". In 
most cases, "N", for not applicable, is the answer you want there.  



Beginning in 2011, some contests adopted the Cabrillo 3.0 standard for their log submissions, while 

others continued to require Cabrillo 2.0. The new standard (embraced by the ARRL, IAARU and some 
others) required a different breakdown of information in the Contest Setup dialog. The one shown 
above is for Cabrillo 2.0. Both dialogs are self-explanatory, but you can find more information on the 
Contest Setup dialog for Cabrillo 3.0 here.  

Next comes the most important part of this dialog, the Sent Exchange field.  

 
 
 

 

For many contests, the program guesses what you will want - for example, in this case, since the 
CQWW contest uses CQ zones, it has already picked zone 5 for me. Note the "Omit RST" warning. If 

the contest you choose has serial numbers, like WPX or the NA Sprint, then you need to put "001" at 
the start of the Sent Exchange field, followed by a single space if there is more to the exchange. 
Hence, for WPX, my Sent Exchange would read 001. An important exception is the ARRL Sweepstakes. 

The serial number is "assumed" for this contest only, so my Sent Exchange for SS would read B 54 
WV. More information on the Sent Exchange is in the Supported Contests section of the manual.  

Once you have filled in the Sent Exchange, you're done for now. Just Click OK and hit Enter.  

2. Trying It Out 

So really, that's all you need to operate contests with N1MM Logger controlling your radio - the Entry 
Window, the Check Window, the Log Window and the Bandmap.  

 

For the purpose of this guide, we'll assume that you're operating in the CQWW SSB contest. In that 
case, the Entry window will look like this:  
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I'm assuming that you're going to operate phone to start, so I have typed in USB in the call-sign field, 
and hit <Enter>. I have left the default frequency (20M phone) in place, but if I wanted to show 
another band, I need only type a frequency (in KHz) in that band (like 21200, for example) in the call-
sign field and hit <Enter> to change bands.  

When I've done these things, I then type a call-sign in the call-sign field. Even before I look at the 

Check window, I see that the call sign is color-coded green. This means that it is both a new contact 
and a double multiplier (in this case, both the new country of Martinique and the new Zone 8). The 
beam heading is displayed below, as are the country, its zone and continent (which affects points per 
QSO). If I have already worked Zone 8 on this band, then the call sign will be color-coded red, 
signifying just a new country. If both the country and zone had been worked before, but the station 
has not, then the color code will be blue. If it is a dupe, the call sign will be coded grey, and the 
warning "Dupe!" appears to the right of the entry fields.  

So, you call him, and he answers. At this point, just hit <Space> to fill in the expected signal reports 

and move the cursor to the Zone field. N1MM Logger uses the <Space> bar as a "smart tab." The idea 

is that it will skip fields you are unlikely to want to change and move immediately to the one you may 
need to. Note, too, that the zone is highlighted. This means that if you need to change it ... for 
example, if FM5BH really was in Zone 9 (he isn't) - you would just type "9" and the "8" would be 
replaced.  

 
 
 

 
Ok, but suppose he's a wise-guy and gives you a "57" report instead. No problem - you just use the 

<Tab> key twice, and the cursor will be on the second digit of the received signal report, ready for 

you to type over. The <Tab> and Shift+Tab work just as you'd expect in Windows, moving forward or 
backward one field. Here's how it looks:  



 
 
 

 

If you need to correct the call-sign, use the <Space> bar to get you quickly there and edit as 
necessary. Then, once everything is as you want it (and the QSO is done), all you do is hit <Enter>, 
and the QSO will be logged.  

One thing that trips everyone up at least once is that the program checks to make sure that you have 
entered everything, and that everything is correctly formatted. For example, if you accidentally fat-
finger the zone number, like "89", the program won't let you enter the QSO. This can be disconcerting 
at first - you get an error message in the status line, like this:  

 
 

 

 

If the program has blocked you from logging the QSO, just use the <Space> bar to move to the 
appropriate field, correct it, and hit Enter to log. If you absolutely can't figure out what the correction 



should be (for instance, with an ARRL section in Sweepstakes), you can hit Ctrl+Alt+Enter to bypass 

the exchange checking and log the QSO "as is." Just in case you want to put a note in the log, when 
you do this a note window opens. Type whatever note you want and Hit Enter, or just hit Enter to skip 
it and get back to the contest.  

Suppose you miscopied a call sign, or he didn't really come back to your call, so you now have a 
mistake in your log. If you need to delete the QSO altogether, just hit Ctrl+D. The program will ask 

you if you really want to move the QSO to a Deleted QSOs file. Just hit <Enter> to do so, or type N 
for No.  

If you need to edit the QSO, hit Ctrl+Q, and put the program in QuickEdit mode.  

 
 
 

 

You'll notice the words QuickEdit above the call-sign field, and that the background of all of the entry 
fields is now blue. You can move through the fields as before and make your corrections. Then hit 
Enter and the QSO will be corrected in the log, or else hit <Esc> to get back to normal logging mode 
and cancel any changes. Be careful not to leave the program in QuickEdit mode for your next QSO, or 
you'll screw up two QSOs at once!  

As you log more QSOs, you'll note that the call-sign of your last previous QSO will appear in the space 

right above the call-sign field. This area, called the Call-Frame, will be very important once you have 
interfaced the program with your radio, but for the moment it is just a reminder of who that last guy 
was.  

 

Remember 

Remember, unless you have interfaced your radio, each time you change bands, you need to enter 
the frequency of that band in the call-sign field, and, if you change modes, enter that there too. For 
example, if you switch to 40M CW, you would need to enter 7000 and then enter CW (separately) 
before you begin logging QSOs on that band. 

 

1.8 Operating a Contest 



 1 Before the Contest 

 2 During the Contest 

 3 After the Contest 

 

1.8.1 Before the Contest 

 1.8 Operating a Contest  

 1.8.1 Before the Contest  
o 1. Update Your Data Files  
o 2. Test  

This section addresses, in a brief and informal way, steps that you should take to get ready for a 

contest season and for each contest. It is worth reading. Where appropriate, links are included to 
point you to more extensive information.  

1. Update Your Data Files 

Make sure you have imported the latest wl_cty.dat file into the database you will be using and 
downloaded the latest Super Check Partial (master.dta) file prior to the contest. Menu options for 
doing this may be found on the Tools menu of the Entry window. Note that the wl_cty.dat file process 
is two steps - first downloading and then importing it into the current database. Both must be done in 
that order.  

If you are using a Call History file, import that into the database also and make sure Call History 
Lookup is on. More information about Call History can be found in this section?.  

Load the function key definition file that you plan to use into the database too. If you make any 

changes during testing, export your function keys to make sure your changes are saved. An 
explanation of how to create function key definitions is found here for CW and here for phone. Click 
here to download Sample Function Key files for the major contests. Click here to watch videos 
about downloading and configuring your data files.  

2. Test 

Today, the program supports CW, SSB and multiple digital modes, close to 300 contests, and a wide 

variety of radios and ancillary equipment. Contest rules change all the time, and organizers often 
forget to let logging software developers know. If this were a conventional software project, any sane 
programmer would declare it "untestable."  

Since its early days, the N1MM Logger project has relied on users to do most of the testing. Rapidly 
releasing relatively small updates, with the option of retreating a version or two if necessary, makes 
this a relatively low-risk approach, so long as users test each one enough in advance of the 
next contest they want to get into.  

If you are planning to operate in a contest a couple weeks from now, load the latest update NOW, 
create a contest "instance" as outlined here, sit down with your radio, computer, DX cluster 
connection, keyers, and whatever else you use, and simulate loging a dozen contacts as if you were 
running (enter a make-believe call, type and hit function keys as fast as you can). Then log a few 

more in S&P mode. Make sure your messages and macros work as expected, make sure you can 
record and playback SSB messages on the fly, make sure the multipliers you think should be counted 
are scored right, log some contacts that shouldn't be multipliers or points and make sure they are 
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handled properly. If operating Assisted, grab some spots, make some spots, check the color-coding of 
spots against the contest rules. Make detailed notes of problems, if any.  

A lot of problems are the result of a local issue - hardware settings, user options or the like. Do take 
the time to check the documentation first, but then don't hesitate to ask for help on the N1MM 

reflector . 4000 users and the N1MM team are there to help.  

With thanks to David Robbins K1TTT, from whose input this section was adopted.  

 

1.8.2 During the Contest 

 1.8.2 During the Contest  

o 1. Making Contest QSOs  
o 2. Bugs Encountered During a Contest  

1. Making Contest QSOs 

Make sure you have your CW or SSB or digital function key definitions set up the way you want, with 
at least 8 messages in the first 8 slots of whichever one you want to use, set up as outlined in Before 
the Contest.  

Now let's begin. There are several ways to make and log a contest QSO with N1MM Logger, depending 
on how much you want to automate the process. The details are the same for either phone or CW. 
The 4 main ways you can use the stored messages are listed here in ascending order of speed and 
convenience.  

1. One key at a time - press a function key when you want to send the associated message. Use the 

<Space> bar to move your cursor. When you have everything filled in, press <Enter>, and the QSO 
will be logged. Done this way, a typical Run (CQ) QSO would look like this:  

1. F1 (CQ)  
2. Station answers - copy call in callsign box  
3. Say his callsign (phone) or press F5 to send it (CW)  

4. Press F2 to send the exchange (either a stored voice message or CW)  
5. Press <Space> to move the cursor to the exchange field  
6. Type in the received exchange  
7. Press F3 to send your acknowledgment  
8. Press <Enter> to log the QSO  

 
2. Semi-CT Style - CT was the DOS logging program that pretty much started all this. It used the 
following convention to save keystrokes.  

Enter the callsign of the station calling you. Press the <Ins> key to send his call and your exchange 
(CW), or speak his call and then press <Ins>. Once you have copied his exchange, press F3 (TU) and 
<Enter> to Log. If you are calling other stations (Search and Pounce, or S&P), you would first press 
F4 to send your call, and when the station responds follow the sequence as above.  

3. Early N1MM style - Enter the callsign of the station calling you. Press the <;> key to send his call 

and your exchange. Copy his exchange and press the <'> (right next to it on US keyboards). The 
program sends the F3 (TU) message and logs the QSO. In S&P, you would hit F4 first, then <;>, and 
then <'>.  

http://groups.yahoo.com/group/n1mmlogger
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This saves some keystrokes, but there's an easier way. A decade ago, N6TR developed the idea of 

making TR Log "modal." By that, he meant that the program would behave differently depending on 
whether you were in Run or S&P mode. Making this distinction let him massively simplify and shorten 
the sequence of keystrokes required to complete a QSO.  

4. Enter Sends Messages - N1MM Logger has now evolved N6TR's invention into what is called Enter 
Sends Messages, or ESM for short. You'll find a full explanation of this mode in this section.  

In short, ESM enables you to enter a callsign and then step through the remaining steps in logging a 
QSO, simply by hitting the Enter key. The program anticipates what you'll want to do next, moves the 

cursor, and highlights what canned message will be sent if you press Enter the next time. Note that if 
you wish, you can still press individual function keys at any time, to send a repeat or otherwise bypass 
ESM.  

Once you've used ESM, we think you'll never go back to the old way again.  

2. Bugs Encountered During a Contest 

When a bug was missed during testing and comes out during the contest please report it on the 
reflector right after the contest or, during the contest if it is a show stopper. Tom and the developers 
participate in many contests but they also read the mail during contests and can suggest work-
arounds or sometimes bring out a new version. In addition, there are many other hams available 
there who can help.  

Rather than writing down problems during the contest, try the following:  

1. Use Alt+N to write a Note that will be attached as a comment to the QSO. For example, "This 
call not in master.dta."  

2. At the end of the contest, use the menu option >View >Notes to see all the notes you have 
made during the contest  

 

1.8.3 After the Contest 

 1.8.3 After the Contest  

o 1. Editing Individual QSOs  
o 2. Entering Multiple QSOs After the Contest  

 2.1. Change Time/Date for a Single Hand-Entered QSO  
 2.2. Change Time/Date for Multiple Hand-Entered QSOs  

o 3. Change All QSO Times/Dates by a Fixed Amount  
o 4. How to Create Cabrillo Files  

o 5. How to Merge Contest Logs  
 5.1. Using N1MM Logger and ADIF Files to Merge Logs  
 5.2. Using Excel and Cabrillo Files to Merge Logs  

o 6. How to Print the Log  
o 7. How to Get Statistics  

1. Editing Individual QSOs 

To edit a QSO, select the QSO in the Log Window and right-click. Select "Edit Contact." The Edit 
Contact Window will appear - for full details see the explanation here.  
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Crackdown on Post-Contest Logging Changes 

Contest sponsors are cracking down on post-contest log "massaging" that uses resources you access 
after the contest is over. The CQWW Contest Committee has recently been particularly explicit about 

this, saying that "the...Committee considers it unsportsmanlike to 'clean' your log post-contest using 
data sources such as recordings, call sign databases, etc." This kind of restriction is not intended to 
apply to post-contest log changes that are based on things you noted during the contest, such as 
problems with the CTY.DAT file, bad abbreviations for counties, states or provinces, etc. If you caught 
it during the contest, you should feel free to fix it afterward. 

2. Entering Multiple QSOs After the Contest 

Computer trouble? Made a paper log during (part of) the contest? The program has some nice features 
that will allow rapid QSO entry, and allow you to easily set the date and time via interpolation. 

(Remember, exact QSO times are not critical for contest sponsors, just within reason) This feature is 
most useful if you have a bunch of QSOs to enter. If you have one or two QSOs on paper you might as 
well do it by editing the Log.  

 Type frequency/band into the Entry Window's Callsign field and hit Enter. Do the same for the 
mode (CW/USB/LSB/RTTY).  

 Enter calls and exchanges, and log them, as long as they are on the same band (don't worry 

about the times, they will be fixed later)  

 At a band change, type new frequency/band, and resume entering QSOs.  

 
Example: 

 
   7000 <Enter> 

 
   LSB <Enter> 

 
   W1ABC 35 CT <Enter> 

 
   W2XYZ 55 MA <Enter> 

 
   14000 <Enter> 

 
   W5JOE 42 TX <Enter> 

 
   ...  

2.1. Change Time/Date for a Single Hand-Entered QSO 

Updating the timestamp of a single QSO is best done by using the Edit Contact option in the right-click 
menu associated with the Log Window. This can also be done can be done from within the Entry 
window using the callsign field. Enter the time starting with "T" and four numeric digits, hit <Enter>, 

and the time of the last QSO will be updated. For example, T1234 will change the time of the last QSO 

entered to 12:34. When entering QSO's after the contest, first log the QSO. Then enter the time Txxxx 
<Enter>.  

2.2. Change Time/Date for Multiple Hand-Entered QSOs 

 

Make a Copy of Your Log 

Make a backup copy of your log database. You cannot (automatically) reverse the time interpolation 
process below. You have been warned! 

http://n1mm.hamdocs.com/tiki-index.php?page=Log+Window


 In the Log window, single-click the first QSO whose time and date you want to change. to 

highlight the row  

 With mouse over the Log window, right click  

 Select >Set Start Interpolation Time Row  

 Enter the new timestamp for the first QSO, and click <OK>  

 Now, click on the last QSO whose time/date you want to change, to highlight the row  

 With mouse over Log window, right click  

 Select >Set Stop Interpolation Time Row  

 Enter desired time for that last QSO, and click <OK>  

 

Changing QSO TIme and Date 

The utility will average out the time for each QSO in the group of QSOs you have selected. 
Remember there is no "undo" feature,. If you have a large gap in time in your hand log, enter the 

first batch of QSOs, and do the interpolation. Then enter the second group of QSOs and do a 2nd 

interpolation. 

3. Change All QSO Times/Dates by a Fixed Amount 

 

Back Up Your Log Database 

While you could easily recover from a mistake during the following adjustment by performing another 
offset, it is still a good idea to play safe. 

This will fix a log where all QSOs are off by a common amount of time  

 Right click in the Log window  

 Select >Change All Contest Timestamps by a Fixed Amount  

 A dialog box will open, and enter offset time (+ or -) in minutes  

 

The date will automatically adjust if the offset rolls a QSO into a different day. Time is entered in 
minutes, and can be negative time to go backwards. (You might need a calculator to determine the 
offset minutes if your date was off by many days, months, or years). For example, entering +1440 will 
shift a complete day forward; -2880 two days back.  

4. How to Create Cabrillo Files 

To submit your log, you need to export it from the database in the proper format. Cabrillo is used by 
all major contests.  

 Select File >Generate Cabrillo File.  

 Make sure that your Station information (Config >Change Your Station Data), and overall 

contest setup are correct (in the Contest Setup dialog, reached through File >Choose Which 
Contest to Log). For example, is your entry class correct? Your power classification? Whether 
Assisted or not?  

 Did you put the right information in the Sent Exchange field, and nothing else? For example, 

when the exchange in a contest is 5NN WV, it may be tempting to put the whole thing in the 
Sent Exchange. That will screw up the Cabrillo file with multiple signal reports for each QSO, 
so get in the habit of putting the signal report in your stored messages, not in this field.  

 A Cabrillo file will be created named <yourcall>.LOG. By default this is placed in the N1MM 

Logger program directory, but you are given the option of putting it anywhere you wish, 
before it is saved.  



It is also a good idea to rescore your log (Tools >Rescore Current Contest) before submitting  

5. How to Merge Contest Logs 

If you ran a multi-op station but did not network your logging computers, you will need to combine 
the logs from each computer into a single log submission for the contest sponsors.  

5.1. Using N1MM Logger and ADIF Files to Merge Logs 

This merge method is the most automated and should require no manual log editing, but will only 
succeed if the contest types in each logging computer were identical. If the contest types were not 
identical, it may be possible to recover with the help of a text editor and some detective work, but it 
will likely not be easy. It's better by far to avoid this situation by using the identical contest types 
during the contest.  

1. Examine the logs to ensure that the contest types are identical in each computer: >File >Open 
Log in Database  

2. Export an ADIF file from each logging computer: >File >Export >Export ADIF to file. Assign a 
unique name to each ADIF file to distinguish it from others when importing. Before continuing, 
guarantee that the contest types from each computer were identical by opening each ADIF file 
with a text editor (like Notepad) and looking for the ADIF expression CONTEST_ID. They 
should all be the same length and contest name. For example: <CONTEST_ID:7>ARRL-FD  

3. Copy all exported ADIF files to the computer that will create the merged log  
4. Launch N1MM Logger in the merge computer. If the merge computer is one of the ones that 

was used during the contest, you will need to create a new database for the merged log: >File 
>New Database. Now in the new database or on the new computer, create a new contest log 
for the merged records: >File >New Log in Database. Be careful to make the contest type 
identical to the contest type that was used during the contest  

5. Import the extracted ADIF files one after another into the new contest log: >File >Import 
>Import ADIF from file  

6. Use >Tools >Rescore Current Contest to rescore the contest  

7. Extract the new, merged contest log for submission to the contest sponsor: >File >Generate 
Cabrillo File  

5.2. Using Excel and Cabrillo Files to Merge Logs 

In some circumstances, it might be easier to combine logs outside N1MM Logger by importing the 
Cabrillo files into a spreadsheet program like Excel. As with the ADIF method, this works best if the 
contest types are identical, or at least use the same Cabrillo format (i.e. similar contest exchanges, 
same columns).  

1. Create a Cabrillo file from each log: >File >Generate Cabrillo file. Assign a unique name to 
each log file to distinguish it from others when importing  

2. Copy all exported Cabrillo log files to the computer that will create the merged log  
3. Combine the QSO records from each Cabrillo log into a single text file using a text editor (like 

Notepad). Open each Cabrillo file, and copy only the QSO records - ignore the header 

information in the beginning and END-OF-LOG statement at the end. Paste this QSO 
information into a new text document (a .TXT file) with the QSOs from every log.  

4. Launch Excel in the merge computer, and import the combined .TXT file into a spreadsheet. In 
Excel: >File >Open, set file type for TXT, and select the merged QSO log file. In the Excel text 
import wizard, declare the original data type as fixed width. In the Data Preview dialog 
window, adjust the field delimiters as necessary to begin each Excel column at the beginning 
of a log field. Press <Finish>. Examine the QSO columns in the spreadsheet to ensure that 

your import was successful  
5. Select the entire spreadsheet using your mouse or <ctrl-A>, then sort the spreadsheet by 

date and time: >Data >Sort, column D (date), and column E (time)  



6. Export the sorted log data to a space-delimited file: >File >Save as >FORMATTED TEXT 

(Space Delimited) .PRN  
7. Using an editor, copy/paste the Cabrillo header information and END-OF-LOG statement from 

one of the original Cabrillo logs into the sorted data file. Rename this file as a .LOG file type 
and submit it to the contest sponsor.  

 

6. How to Print the Log 

There is no specific option for printing a log. However, if you Click on Export on the File menu, there's 
a variety of options.  

 

The most likely reason for wanting a printed log is for awards submissions or archiving. Because 
N1MM Logger is not intended as a general-purpose logging program, it does not offer award tracking 

functions. However the ADIF file option will give you a file that can be readily imported into all popular 
general loggers. If you just want something for a notebook, the Generic export will give you a text file 
that can be printed from Notepad.  

7. How to Get Statistics 

From the View menu item in the Entry window, choose Statistics. This tool allows you to select any 
two data points of interest. For example, you can select hours for the Row and Zones for the Column, 
and the program will display a table of how many QSOs in which zones were worked in which clock 
hours. This is a lot easier to use than it is to explain in words, so give it a try.  

 

1.9 Finding Help 

 1 On-Line or Off-Line Documentation 

 2 N1MM Logger Discussion Groups 

 3 Tips and Tricks 

 4 Most Frequently Asked Questions 

 5 Troubleshooting 

 

1.9.1 The On-Line Manual or Off-Line PDF Files 

 
This wiki-based manual is now maintained in real-time by volunteer authors who make changes to this 
document as the program changes. If you are reading this on the web, you are reading the absolute 

http://n1mm.hamdocs.com/tiki-index.php?page=On-Line+or+Off-Line+Documentation&structure=N1MM+Logger+Getting+Started
http://n1mm.hamdocs.com/tiki-index.php?page=N1MM+Logger+Discussion+Groups&structure=N1MM+Logger+Getting+Started
http://n1mm.hamdocs.com/tiki-index.php?page=Tips+and+Tricks&structure=N1MM+Logger+Getting+Started
http://n1mm.hamdocs.com/tiki-index.php?page=Most+Frequently+Asked+Questions&structure=N1MM+Logger+Getting+Started
http://n1mm.hamdocs.com/tiki-index.php?page=Troubleshooting&structure=N1MM+Logger+Getting+Started


latest version of the N1MM Logger manual. It may lag announced program changes by a few days, but 
hopefully not more than that.  

However, you may need to access the N1MM Logger manual from a location without Internet access; 
or you may prefer using Adobe Reader to view and search the manuals.  

There are two methods for accessing the pre-built copies of the documentation in Adobe PDF format. 

Instructions for downloading the files can be found here: Download Existing PDF Files   

To make your own off-line copies of the current English manual (either printed paper copies, or 
electronic PDF / HTML copies), see the Off-line Copies of Wiki Documents chapter in the wiki Users 
Guide.  

 

1.9.2 N1MM Logger Discussion Groups 

 1.9 Finding Help  

 1.9.1 The On-Line Manual or Off-Line PDF Files  

 1.9.2 N1MM Logger Discussion Groups  

o 1. General Information  
o 2. Rules for Posting to the Yahoo Reflector  

1. General Information 

These groups, with literally thousands of members, are devoted to all aspects of N1MM Logger, from 
proposed features to questions and reports of bugs. You are virtually assured of a quick answer to 
questions on almost any subject, though it may help the mood a bit if you first search the archive and 
check the documentation to see if the issue is covered and readily findable..  

 General group: Messages dealing with general program issues (including specific CW and SSB 

contests) should be posted to the General Group .  

 Digital group: Messages dealing solely with digital mode issues (including digital contests) 

should be posted to the Digital Group .  

 
In general, messages should not be cross-posted. This is important, both to get the benefit of the 

subdivision and to encourage users to subscribe to both. Users are asked please to separate digital 
and general/non-digital issues into individual messages and post them in the right places — on the 
receiving side, all e-mail software has tools to sort e-mail into folders by source, so nothing should get 
lost.  

The development team will continue to track both forums and respond on the one that seems 
appropriate.  

So if your interest is primarily digital, for example, you may want to subscribe to the general group in 
one of the digest formats available. If it is primarily non-digital, then you might do the same thing, in 
reverse.  

 

Digital Operators 

Digital operators are well advised to subscribe to the general Yahoo group and the digital Yahoo 
group, even if not interested in CW or SSB, because general things about the program that affect 

http://n1mm.hamdocs.com/tiki-index.php?page=Download+Existing+DPF+Files
http://n1mm.hamdocs.com/tiki-index.php?page=Off-line+Copies+of+Website+Documents#N1MM_Users_Guide
http://groups.yahoo.com/group/N1MMLogger
http://groups.yahoo.com/group/n1mmlogger-Digital


them (font changes in various windows, for example), are likely to be discussed there rather than in 

both lists. 

 
General program issues Digital program issues  

 
(including CW and SSB contests) (including digital contests)  

Post 
message 

N1MMLogger@yahoogroups.com N1MMLogger-Digital@yahoogroups.com  

Subscribe 
N1MMLogger-
subscribe@yahoogroups.com 

N1MMLogger-Digital-
subscribe@yahoogroups.com  

Unsubscribe 
N1MMLogger-
unsubscribe@yahoogroups.com 

N1MMLogger-Digital-
unsubscribe@yahoogroups.com  

List owner N1MMLogger-owner@yahoogroups.com 
N1MMLogger-Digital-

owner@yahoogroups.com 

 
Everybody can read the messages from the support groups. To send messages you have to join the 

group. Your first post must be approved by the moderator. This prevents spammers from using the 
list. There are close to 4000 members on the general list and almost 900 on the digital group.  

2. Rules for Posting to the Yahoo Reflector 

1. When you report a problem you should have tried to reproduce it using the latest version. We 
don't support any but the latest version. Please include:  

1. Program version  
2. Operating system version, bits & memory  
3. CPU speed  
4. Contest name  
5. Radio types (and connection particulars if this is an radio i/f problem). Make sure you 

indicate whether you are using a usb to serial adapter.  
6. SO1V/SO2V/SO2R  
7. Any port sharing software (LP Bridge, VSPE, etc.). We don't support those but you are 

welcome to ask the group for advice.  
8. Any error code AND description in the original language and in English if you can 

translate it.  

9. Mode and method of interfacing to that mode:  
1. CW: LPT/Serial/Winkey?  
2. SSB: Sound card interface  
3. RTTY: interface, RTTY engine(s), AFSK/FSK, etc.  
4. A detailed description of the problem. Don't just say, "Hey I installed the 

program and I got an error! What's up with that? Anyone else seeing that?" 
Save everyone some time. Document the situation in your post.  

2. Be proud of your callsign. Put it in every post. If you don't put it in your first post, I won't 
approve it.  

3. Don't spam. These are groups for discussing the program. People subscribed for that reason. 
They don't want for sale messages, announcements of your contest, or other off topic posts.  

4. Think about the topic of your post before you post it. Make the subject relate to the specific 
content of your post. The following are useless subjects:  

o N1MM  

o Hey!  
o A quick question  
o N1MM Logger bug report  

5. Add SOLVED to the title of a post that contains the solution to a problem you posted. PLEASE 
post the solution. People have put effort into helping you solve your problem. Do them the 
courtesy of posting the solution. I once sent an HF radio in for repair when I had accidentally 

turned the squelch and there was no audio. We all do embarrassing things. Fess up if you did 
something like that and asked for advice.  



6. Read all the posts about a subject before you post a response. If a post already says what you 

were going to say, avoid saying "me too!". It just clutters up the group with messages.  
7. If you have a post that is a digi problem, post it on the digi group.  
8. If you ask a question, check for answers. It is RUDE to check back 3 days later. Check back 

within an hour, 8 hours max. NEVER say, "please reply direct, I don't check the group for 
messages." If you are going to ask 4,000 people to read your post in order to get your 
problem solved, you owe it to them to have the answers posted on the group. Exception: You 
can ask for direct responses if you are doing a survey and post the results after compilation.  

9. Join the group before you have a problem. We approve new users several times a day, but 
sometimes we go on vacation (believe it or not) and only approve once a day.  

10. Post your message at the top of the message thread and include the whole thread. It saves us 

a lot of time researching problems if you follow this rule.  
11. Above all, remember that you are going before 4,000 people with your posting. Take some 

time to prepare what you are going to say, rather than just dash off some half-baked post. I'll 
never forget what Mrs. Peoples, my high school English teacher said about one of my error 
filled papers, "If you didn't bother to read this, why should I?"... Same thing applies here. If 
you want help, demonstrate your willingness to do your part of the work.  

 
73,  

Tom - N1MM  
posted to the reflefctor 2013-02-07  

 

1.9.3 Tom's N1MM Logger Tips and Tricks 

 1.9.3 Tom's N1MM Logger Tips and Tricks  
o 1. Bandmaps, Entry Windows and the Mysteries Thereof...  
o 2. Bandmaps and the Available Window, What are They Good For...  
o 3. N1MM Logger Contest Technique  

o 4. Start of the Contest Season  
 4.1. Testing  
 4.2. Key Assignments  
 4.3. Enter Sends Messages (ESM) Mode  
 4.4. Dual Entry Windows  
 4.5. Configurer Options  
 4.6. Autocompletion Mode  

o 5. Log Editing  
o 6. Force to Log Whatever Heard  

 6.1. Country Not Found When Logging Contact (no mulitplier credit)  
o 7. Having F1 NOT Always Send CQ  
o 8. Silence the Function Keys  
o 9. How I Recommend to S&amp;P on a New Band  
o 10. Setting Contest Goals  

o 11. Problems During a Contest  
o 12. Using Up/Down Arrows to Tune  

o 13. CW Tips  
 13.1. CW Macro Tip  
 13.2. Contest Spacing for CW  

o 14. Working Dupes  

o 15. What Setting Should I Use for Packet Spot Timeout?  
o 16. How Should I Really Use this Program if I am Single Operator Assisted (SOA)?  
o 17. How to Find a Worked Station in the Log?  
o 18. Databases versus Contests  
o 19. How to Upgrade the Database to a Newer Version? Move It to Another Machine?  

 19.1. Deleting QSOs (especially important for Multi-User)  



o 20. QSYing Wipes the Call & Spots QSO in Bandmap  

o 21. Exchange Abbreviations  
o 22. Too Many Calls on the Bandmap!  
o 23. Gray Line Openings  

o 24. QSO Confirmation  
o 25. Packet/telnet Button Setup  
o 26. Move RX Frequency from the Keyboard  
o 27. Recording QSOs  

This chapter gives some tips and tricks on using the program. All tips are from Tom, N1MM unless 
otherwise mentioned. The tips are examples how you could use the program, not how you should use 
it. That is up to you!  

1. Bandmaps, Entry Windows and the Mysteries Thereof... 

 
Two Entry Windows  

Here is what you should be able to do:  

 Change keyboard focus with backslash \  

 Change keyboard and transmit focus with Ctrl+left/right arrow or toggle with the <Pause> 
key.  

 
With one vfo on one band, and another on the same or second band, you should be able to jump from 
spot-to-spot using Ctrl+up/down arrow on the main vfo. With Ctrl+Shift+Up/Down arrow , you 
should be able to jump from spot to spot on the secondary vfo. If your radio has dual receive (Orion, 
FT-1000 series), you should be able to listen to both VFOs at once. Alt+F12 swaps MAIN and SUB 
receiver. 

 

With the Orion and FT-1000 series, the way I envision this being used in S&P: You would find a station 
on the main vfo, and wait for it. In dual receive, you would used Ctrl+Shift Up/Down arrow to find 
another station that is ready to be worked. You would call whichever station is ready first. This could 
be done on two bands (SOA), or on a single band (MM). If one has spotted a number of calls locally 
(QSYing wipes the call & spots QSO in bandmap), one could use it on one or more bands in SO.  

Bandmaps - Clicking on a spot on either bandmap will set that vfo to keyboard & transmit focus, 
and put the call in the callframe. Double-clicking will put the call in the callsign field.  

Please print and read the keyboard assignments help. You will be rewarded with greater enjoyment of 
the program. Trust me.  

2. Bandmaps and the Available Window, What are They Good For... 

The ONLY time they are to be used is for Search & Pounce AND the only thing they are good for is to 
do a quick match up of a partial call you hear on the radio with what you are seeing go by in the band 
map so you can keep moving instead of stopping to listen. That being said, the size of the band map 
can be kept small and well zoomed so it only shows a narrow part of the band...  

Now why you might ask?? I want to see multipliers that just got spotted at the bottom of the band 

when I'm CQ-ing up at the top of the band, or I want to see multipliers on another band. THAT is what 
the Available window is for! Learn to use it and it will serve you well in finding multipliers on other 
bands. So shrink the band maps and enlarge the Available window and  
be more efficient at both scanning the band yourself and grabbing spots. Now wait, what about if I 



want to tune up the band to the next multiplier, shouldn't I have more band map shown so I can click 

on the next one up the band??? NO, that is what Ctrl+Alt+Up Arrow/Ctrl+Alt+Down Arrow are 
for, if you want to click on mults use the Available window list instead... sort it by frequency  
if you must, but I prefer to go after the freshest spots first since they are most likely to still be there. 
73, Dave K1TTT  

3. N1MM Logger Contest Technique 

I can't emphasize this enough. All the pretty bandmap stuff is not there to look nice. It's there to help 
you make Q's. Here is how to do it...  

When there are lots of spots in the bandmap, you can work lots of stations with S&P. Start anywhere 

in the band. Press Ctrl+Up. Listen. Is he CLOSE to ready to be called? If yes, call him. If not, press 
Ctrl+Up again. Repeat this until you work through all the available Q's. This way you don't waste time 
listening to endless repeats when one station is working a weak one. I have made a 90/hr rate doing 
this.  

More tips: If a spot is dead, or not in a legal part of the band, use Alt+D to delete it. You won't have 
to stop at it next time.  

If you don't want to see spots for the wrong mode, right-click Allow spots for this contest's mode(s) 
only in the packet window. Be careful using this one on 80 & 40.  

Print the Key Assignments for how to jump between mults.  

Variation: You are CQ'ing, but the rate is slow. Use the S&P technique to jump between spots. Then 
quickly return to your CQ frequency with Alt+Q.  

Unassisted S&P: DO NOT TURN OFF "Show non-workable spots". The only exception is for Sprint 
contests, such as the NA Sprint, EU Sprint and AP Sprint, where stations change their frequency after 

every QSO. Here is my recommendation. Tune up or down the band, listening and watching the entry 
window for band edges, but also for calls that you have heard before or worked before in the 
callframe. If the call is unworkable, speed up your tuning, and find the next station. When you come 
to a station who is working someone else, type in his callsign. Work him if it is quick. If not, tune on, 
and the guy's call will be spotted. Tune up for a short time, then return to his freq with Ctrl+Up or 
Ctrl+Down. If he is ready, work him, if not repeat the process of trying to find another station.  

The bandmaps are not supposed to be nice & clean. They are supposed to show you where stations 

can be worked. The bandmaps can be zoomed with the numeric +/- keys or by right-clicking on the 
bandmap. It is important to know if a frequency is in use to save time listening to a dupe or non-
workable station.  

The final, dirty little secret... What do you call a spot where there is no station? Your new CQ 
frequency...  

Rate is everything...  

4. Start of the Contest Season 

Approaching CQWW SSB means the start of the main part of the contest season. Enhancements to the 
program will be curtailed during this part of the year to focus on eliminating any bugs or performance 
problems.  

4.1. Testing 



Please start testing with your favorite fall/ winter contest in the autumn. Make a copy of ham.mdb (or 

whatever you have called it), and use last year's contest as a test platform. Why?  
Some problems only appear with larger logs. Find out performance issues. I rely on the users to let 
me know about them.  

See Before the Contest for suggestions on how to test. Be sure to test anything that is unusual in your 
station set-up, in caase a gremlin has crept in that other testers haven't discovered. Report what you 
find on the reflector.  

4.2. Key Assignments 

Now is also a good time to review the Key Assignments. That is a good place to start to pique your 
interest in what the program can do. The Key Assignments Shortlist is great to print and hang beside 
the radio.  

4.3. Enter Sends Messages (ESM) Mode 

If you are planning to operate CW or RTTY, you MUST learn about ESM (Enter Sends Messages). It 
reduces fatigue and errors by sending the right message each time just by pressing Enter. It may take 
you a while to understand and set up ESM, so don't leave this to the last minute. Believe me, those 
that learn to use ESM, love it.  

4.4. Dual Entry Windows 

It would be a good idea to try those out, so you don't get frustrated during the contest. For your 
reference:  

\ backslash switches keyboard focus, Ctrl+left/right arrow and <Pause>change keyboard & 
transmit focus.  

Also, Ctrl+Fn, and Ctrl+Enter send on the radio that does NOT have focus.  

4.5. Configurer Options 

Finally, make sure you understand what settings you want for the following Configurer options:  

 SO2V/SO2R  

 Send corrected call  

 Send partial calls  

 Stop sending CQ when callsign changed  

 ESM only sends your call once in S&P, then ready to copy received exchange  

 Config/QSYing wipes the call & spots QSO in bandmap  

4.6. Autocompletion Mode 

Later in a contest, you hear a lot of stations that you have already worked, whether on this band or 
another band.  

If you check Autocompletion mode (Configurer | Other tab) the program will match the first characters 
that you typed to previous callsigns. It will then pre-fill the callsign field with the rest of the call. The 
portion of the call that you did not type will be highlighted, and you can remove it with the delete key. 
However, if you press space, the call will be kept in its entirety.  

This function is similar the technique used in Internet Explorer to "guess" which URL you are typing.  

http://n1mm.hamdocs.com/tiki-index.php?page=Before+the+Contest#Test


Some like it, some don't. Try it with an existing log that has a large number of QSOs.  

5. Log Editing 

You should rarely/never have to use the edit window during a contest. To get back to your last QSO, 
press Ctrl+Q. To go back another QSO, use Ctrl+Q again. And again. To go forward, use Ctrl+A. 
These keys ignore QSOs made by other stations when in Multi-User mode. It is also much better, 
because you are using the same Entry window to edit that your fingers have gotten used to. To 
abandon edit of a QSO, press Escape. The background color of the text panes changes while in 
"QuickEdit" mode.  

6. Force to Log Whatever Heard 

Ctrl+Alt+Enter will force the program to log whatever it doesn't recognize in the exchange field. The 
receive frequency is being reset to the transmit frequency.  

6.1. Country Not Found When Logging Contact (no mulitplier credit) 

 

1. The preferred way to handle this is to load the latest wl_cty.dat file prior to the contest 
 
2. A second way to handle it is to force a particular call to a country with >Tools >Add Call to Country 

o Note that this addition will be wiped out on the next reload of the country file  

3. A third way to handle it is to add a note (Alt+N) to the QSO, and fix it later. >View > Notes will 
help you find those QSOs with notes  

7. Having F1 NOT Always Send CQ 

Pressing F1 will send the F1 message. Typically, F1 is defined as the CQ-key in the Function keys tab 
in Configurer. Pressing the CQ-key (i.e. F1 will place the program in Run mode. If you do not want to 
go to automatically switch to Run mode when you press the CQ-key, use the {S&P} macro in the F1 
S&P key (13 th row).  

8. Silence the Function Keys 

If you want to 'silence' the function keys so they do not send anything and do not PTT the radio, just 
put a single blank space in the Fkey contents of the button you want to silence. A space is a real 
character, but not one that is transmitted, and the program knows not to switch the PTT in that case.  

9. How I Recommend to S&P on a New Band 

1. Look at the Available window. Are there any Mults to be had? (You should already know this, 
since you just chose this band.)  

2. If there are mults to be worked, use Ctrl+Alt+Up/Down to jump to them on the Bandmap. 

Look at the Call-Frame for the callsign. Use your ears to decide if that's the station and that 
they are near ready to work you  

3. Jump through all the mults until you have worked those that you can in a reasonable time. 
You may need to repeat the search several times to get them all. Note that you don't want to 
spend a lot of time waiting for them. Just keep going up and down the band and clean 'em out  

4. Repeat the process with Q's that are available (Ctrl+up/down). When you find a dead 
frequency, try a short CQ. Maybe you can get a run going. Otherwise, clean out the available 

QSOs  



5. Once you have worked all the spotted stations (assuming assisted), start manual S&P. Turn on 

"QSYing wipes the call..." option. If a station is hard to work, just keep going. The call will be 
spotted on your computer(s) only. You can use the technique in steps 1-4 to work him  

6. Spot non-workable stations if you are a good typist. It's nice to know where they are so you 
don't waste time on them during the next sweep.  

10. Setting Contest Goals 

How do you get better at contesting? One way is to set goals for yourself.  

The info window supports this by allowing you to set how many QSOs per hour you want to try to 
accomplish. As you are contesting, the four rate panes will let you know if you are at less than 50% of 
goal (red), between 50-100% of goal (yellow), or ahead of goal (green).  

Note whatever goals you set for an hour will continue until the hour for the next goal is reached.  

What if you want to beat last year's score?  

The program supports that as well. Just open LAST year's log, and click the Import Goals button. 
Choose the day (1 or 2) and press enter. You goals are now set to your hourly totals from last year. 
Don't forget to start a new log for this year!  

The goals will be kept until you reset them explicitly or until you LOAD A NEW DATABASE. If you 
forget this, the goals won't make any sense, because they will not be the ones from last year's version 
of your current contest.  

You don't want to have a different database for each (small) contest. This is a common misconception.  

11. Problems During a Contest 

What do you do if you have problems during a contest?  

1. Make sure you have a previous version of the logging program around that you have used 
successfully in the past.  

2. Make sure you have tested the program ahead of time using the modes you plan to use 
during the contest. Log a few sample QSOs. Check all the windows you plan to use. Connect to 

packet or telnet if that is your plan. You might want to run through a test plan.  
3. If you find problems before the contest, please send the bugs in to be fixed as much before 

the contest as possible  
4. Check the update page on the N1MM website. We frequently fix problems during the 

contest. The problems that we try to fix are either fatal ones, or low-risk ones. Nonessential 
functions that present some risk to fix, are left until after the contest.  

12. Using Up/Down Arrows to Tune 

The Up and Down arrow keys can be used to tune your radio. If you are in S&P, then just use them to 
tune in the station you are trying to work. This is particularly good for packet spots.  

If you are Running, you might try this technique. Set your radio up for split, and use the up/down 
arrows as RIT.  

The amount to be tuned up/down with each keypress is set in the Configurer >Other tab.  



13. CW Tips 

13.1. CW Macro Tip 

Some calls have letter combinations where it's hard for to copy correctly. For example, 6Y2A is often 
copied as BY2A. To help make your call easier to copy, Go to >Config >Change Packet/CW/SSB/Digital 
Message Buttons >Change CW Buttons, and try changing the default F1 and/or F4 message where * is 
used for your call. In this example, 6Y2A changes F4 from * to >6<~Y2A. 

 
Result: the 6 is sent 2 WPM slower compared to the rest of the call, and an additional half space is 
added between the 6 and Y. Try other combinations of <, >, or ~ to make your call easier to copy.  

13.2. Contest Spacing for CW 

Select >Config >Ports, Mode Control, Audio, Other >Function Keys >Use Contest Spacing for CW. The 

box is default ON. This setting changes the spacing between words in your CW, where "N1MM 599 5" 
is 3 words. Default is 6 bits for "contest spacing". When this box is not checked, 7 bits between words 
is used, which is "normal spacing".  

14. Working Dupes 

The default is to work them if you are the CQing station, but not to call them if you are S&Ping. The 
theory behind working dupes while running is that it's faster to work them than it is to argue, and you 
might really not be in their log. If that is the case, and they submit a log, you'll lose points by not 
working them.  

The "work dupes" option in the Configurer is for ESM and running mode. All it does is determine what 
is sent when a dupe calls you AND YOU PRESS ENTER.  
When using Enter Send Message (ESM) mode the behavior is as follows:  

 In S&P using ESM, if you press Enter with a dupe call in the Entry window nothing will happen 

(intentional), but you can always work him by pressing F4 instead.  

 In Run, using ESM, with "Work Dupes" checked, when you press Enter you will send his call 

sign and the exchange whether he is a dupe or not. If you want to send "QSO B4" you can just 
press F6 instead.  

 If you don't have "Work Dupes" checked, then to work a dupe in Run mode you will have to 
press F5 and then F2 to send his call sign and the exchange; pressing Enter will send the F6 
message.  

 
All that being said, you can work dupes in either situation (Run and S&P) by pressing the F-keys.  

A goal of the program is to promote good operating. Working dupes while running is good operating. 

That's why work dupes is the DEFAULT. It is an option because an argument was made that in a long 
exchange contest like SS, you might not want to automatically work dupes.  

What I suspect happened is that someone turned work dupes off while playing with the program. This 

is a complicated program. Changing options that you don't know the meaning of can lead to a lot of 
confusion. My advice is:  

1. Get the program working with your equipment  
2. Save the ini file  
3. Play with the options  
4. Discard that ini file and revert to the one from step 2  



5. Change any options you feel you truly understand and want changed  

6. If an option doesn't seem to "do anything" — watch out! You might want to set it back to the 
original setting  

15. What Setting Should I Use for Packet Spot Timeout? 

For general DX-ing, 30 minutes is not too long. 
 
For a contest, you might want to crank it down to 20 minutes, since there is more movement of 

stations. Also, a lower timeout will mean fewer spots are managed by the program. This may help 
performance for those with marginally performing machines.  

For testing packet spot behavior when there are few spots, or for testing performance, a timeout 
setting of 1000 minutes might be right.  

16. How Should I Really Use this Program if I am Single Operator Assisted 
(SOA)? 

Try these techniques:  

 Connect to a Telnet node. Do a sh/dx/100 to fill up the Bandmap initially.  

 Pick the band with the most mults as shown in the Available window.  

 Go to that band and use Ctrl+Alt+Up arrow and Ctrl+Alt+Down arrow to work all the mults on 
the band. Don't waste too much time on each one.  

 Go back through the band and use Ctrl+Up arrow and Ctrl+Down arrow to work all other 
stations on the band. If you find that a frequency is dead, do you know what you call that? 
You call it your new RUN frequency! Call CQ and get a run going.  

 When the run is over, go pick up any more mults or QSOs on this band.  

 Now, either move to another band and repeat, or try these techniques. Turn on "QSYing wipes 
the call & spots QSO in bandmap" Tune up or down through the band, looking for stations you 

haven't worked. Enter all or part of their calls, then tune off. The call will be "spotted" in the 
bandmap. You can use Ctrl+Up/Down arrow to work them later. Again, what do we call a dead 
frequency? That's right, it's a RUN frequency. ;-) (As you are doing this, if you can work the 
station without waiting, of course you should work it.)  

 If you don't want to type a call, and you know you don't want to work the station, you can 

mark the frequency busy with the Mark button (Alt+M).  

 As you are tuning, watch the Bandmap. It will give you big hints as to whether you should 
waste time listening to a station. If you start hearing "grumble grumble" 2 kHz away from the 
frequency marked with Joe down the street's call, you know to speed right by.  

17. How to Find a Worked Station in the Log? 

There are three possibilities to find a worked call in the log. The results are shown in the bottom pane 
of the Log window.  

 When entering the beginning of a callsign in the Entry window, after 3 characters a worked 

station starting with these three characters will be shown automatically in the bottom pane of 
the Log window.  

 You can use the <?> wild-card character - for example entering N?M this is also enough to 

show N1MM and every other station that ends with N?M.  

 When you only have 1MM and missed the first part of the prefix you can place a * in front of 
the characters you have. *1MM will show N1MM and every other station that starts with 1MM 
in the callsign.  



Combinations are also possible:  

 *1?M will show N1MM but also K1MR, J41YM etc.  

 *3? or *3* will show all worked callsign with a 3 in the callsign  

 *3*Z will show every station with a 3 followed by a Z somewhere in the callsign like K3ZO, 
VA3UZ etc.  

Using a * is called a "like" search in SQL. The problem is that a "like" search is very slow so on slow 
computers this will take some time.  

In VHF contests use Alt+= (equal) and the program will search everything which matches the content 
of the callsign and the gridsquare fields.  

18. Databases versus Contests 

There is a lot of confusion about how contests are stored in the logging program.  
To clear this up, let's start with a couple of definitions:  

Database - an Access 2000 format database file with a file extension of .mdb. Any number of 
contests may be stored in a database.  

Contest - a set of QSOs within the database. They are stored in rows in a table called DXLOG. Each 
contest row has a ContestNr which ties it to a ContestInstance entry.  

Much of the confusion comes from people thinking that they need to have only one contest in a 

/database. This is not the case. I have only one database that I log "official" QSOs in. (Of course I 
have many test & backup databases.) Why? because the performance of the program is not very 
sensitive to database size. I currently have about 14,000 QSOs in my database.  
Now if you plan to go on a DXpedition and log 25,000 QSOs, I would recommend a separate database 
for that. For most users, no.  

Another thing. Did you ever notice the option"Copy (and compact) Database". This is one I bet you 
never use, but should use. Deleted space in most databases is not recovered automatically, and 
Access is no exception. If you delete a contest, or delete contacts (see tip on deleting contacts), you 
will need to run this option to recover the space. Do you need to run it every day? No. Maybe once 
every 6 months would do for most people, or before archiving a database.  

The most important thing to remember about databases is to BACK THEM UP. Periodically copy your 

database to a backup device, or zip it up and copy to a floppy. Even e-mailing it to work would do! It 
is your entire record for all of your QSOs using the program. Don't lose it. Also, if you are going to 
import data, or delete data, that is a good time to back up your database. If you don't have the data 
any more, no one can help you!  

19. How to Upgrade the Database to a Newer Version? Move It to Another 
Machine? 

The best way upgrade the database to the current version by opening it with a current version of the 
program on the first machine. Then you can open it with the same version on the second machine, 
and no database upgrades will need to be done.  

Please do a backup first!  

What is meant by a "database upgrade"? From time to time, columns, indexes, data etc. are added to 
the database. For each of those changes, the program queries the database to see if the change has 



already been made. If not, the program automatically makes the change. To the user of the program, 
this is automatic. All the user will notice is that program startup takes some additional time.  

This works very well. Haven't had any complaints. Nevertheless, a database that is a year or two since 
the last time it was opened will have quite a bit of updating to be done. Why not do it on a known, 
working machine?  

19.1. Deleting QSOs (especially important for Multi-User) 

This topic affects all users, but multi-user contesters the most.  

As part of the multi-user support, a DELETEDQS contest was implemented. When a contact is 
"deleted" with Alt+D or the Delete key, it is not really deleted. It is moved to the DELETEDQS contest. 
Yes, you could go to DELETEDQS, and remove it, but that would not be wise. Why?  
Because there is no reason to delete it, and there are good reasons not to. With it in DELETEDQS, you 
can recover it by exporting it to an ADIF file, changing the ADIF file and importing it into the original 

contest. That, however is not the overriding reason not to touch DELETEDQS. The main reason is a 
Multi-User reason.  

In multi-user, DELETEDQS is how I determine to "delete" a contact in the logs of other stations. Since 
no contact is ever really deleted, I need only gather all the QSOs and DELETEDQS logged by a station 
and add or update them in the other station's logs. This lets me avoid the danger of deleting rows in a 
database. Therefore, DON'T MESS WITH DELETEDQS during the contest. Make a backup after the 
contest of all the stations' logs. Then you can do anything you want, and I can help you recover, since 

you have a backup. If you don't follow this advice, you will not be happy.  

Oh, but if it is a dupe, that's different, right? NO! Log dupes. Cabrillo doesn't care, the contest sponsor 
doesn't care, and it doesn't hurt your score. It CAN help your score. Log those dupes, and DON'T 
delete them.  

20. QSYing Wipes the Call & Spots QSO in Bandmap 

Have you ever noticed that the logging program will "spot" dupes in the bandmaps. That is, if you type 
in the call of a dupe then tune away from it, the entry fields will be cleared (wiped) and the call placed 
in the bandmap.  

That feature is always active. There is a similar feature that you must turn on to use. It is called 
"QSYing wipes the call & spots QSO in bandmap". It does the same thing as the dupe spotting, but for 
other calls you enter. You must be in S&P mode for this to work.  

This option is good for combing a band for stations to work during a contest. If a station you hear is 
not finishing a qso, you can move on to find another. The program will spot the call in bold, and you 
can use Ctrl+Up/Down to go back through and work the ones you skipped.  

21. Exchange Abbreviations 

What are exchange abbreviations?  
Some contests require sections, counties or other entities for the exchange. These must be LOGGED 

with standard abbreviations. The menu item >Config >Change Exchange Abbreviations allows you to 
edit them.  

What if you don't like for example the standard ARRL abbreviations? Well, you can enter your own. 
Let's say you'd like to enter CONN for CT. You can ADD CONN CT in the exchange abbreviation list and 
if you enter CONN or CT, the program will LOG CT. Don't replace the abbreviations that are already 



there. It's best to just add the ones you like. (I use the presence of certain abbreviations to determine 
whether to reload some of the lists.)  

22. Too Many Calls on the Bandmap! 

What do you do if the calls are crowded together on the bandmap? You need to zoom in or out... 
 
There are two ways to do it. On a traditional keyboard, using the numeric pad plus (+) and minus (-) 
keys will zoom the current bandmap. The current bandmap is the one with the cyan frequency display. 

If you want to do it with the mouse, hold the cursor over the bandmap you want to zoom, then right 
click. Choose zoom in or zoom out.  

It is also possible not to show "non workable contacts". This means that only the stations are shown in 
the bandmaps which are valid QSOs in the contest and not have been worked before (all normally 
gray contacts will disappear from the bandmaps).  

23. Gray Line Openings 

Watch for gray line openings when your sunrise or sunset match the other station's sunrise or sunset. 
You must have entered your lat/long accurately (watch the +/-) in the Station dialog. Your sunrise & 
sunset times can be found in Help/About. 
 
Sunrise & sunset for a prefix or call can be found by typing it in the entry window, and looking at the 

Info window. Note that the sunset & sunset times are for whatever central point in that country is 
specified in the loaded country file (wl_cty.dat or cty.dat).  

24. QSO Confirmation 

Some contest rules state that the received exchange must be acknowledged for the QSO to count.  
If a contest sponsor wants you to acknowledge (i.e. confirm) the exchange, they mean for you to send 

"QSL", "TU", or "R" to indicate receipt.  
This does not mean a resend from the report back to the station. A resend would provide verification, 
not acknowledgment. Only under rare circumstances would you ever repeat the other stations 
exchange.  

25. Packet/telnet Button Setup 

Here are the buttons I currently use for AR-Cluster nodes: I don't think these are necessarily optimal, 
but they give you an idea of what is possible.  

NE only means (near) New England only. (W1 & W2). The first column is the command, the second 
column is the button label. & in the button label makes it an Alt hotkey.  
Anyone want to post a similar list for other cluster software? (Please test them first.) Also, what about 
screening out cw or ssb spots when in a single mode contest?  
Note that the menu item >Tools >Clear All Spots will remove all spots from the bandmap. You might 
decide that there was too many unreadable stations in the bandmap. You would set a filter (below), 
then clear all spots. You could then use sh/dx/100 to refill the bandmap.  

Button text Command  

BYE BYE  

CONN C K1TTT  

DI/N DI/N  

SH/DX SH/DX/30  

USERS SH/U  



WWV SH/WWV  

Clear NE set/filters dxorigstate/off  

Yes DX set/filters dxorigcty/off  

NE only set/filters dxorigstate/pass ny,nj,ct,ri,ma,nh,vt,me  

No DX set/filters dxorigcty/pass k,ve, xe  

No VHF set/filters vhf/reject  

K1TTT {MYCALL} 

26. Move RX Frequency from the Keyboard 

At a local club meeting last night we watched the FO0AAA video. I've seen a number of other 
DXpedition videos before and they all show the operator reaching over after each or so QSOs and 
moving the RX frequency. Given this is standard practice for DXpeditions, both SSB and CW, I thought 
it would be a useful feature to have that function built into the logging program.  

There are already two ways to do this in N1MM Logger.  

1) If you are in Run mode, and turn on RIT on your radio, then the Up/Down arrow keys change the 
receive frequency without changing the transmit frequency.  

2) If one sets the radio on SPLIT and TXs on the second VFO, pressing either UP/DOWN ARROW 
moves the RX frequency up or down by the amount set in the Config/Configure Ports/Other screen. It 
also works well for regular contesting. Put the radio on SPLIT SIMPLEX (A=B) and use the UP/DWN 

arrows instead of the RIT for those off frequency callers when you're RUNNING. (thanks, Gerry, 
VE6LB/VA6XDX)  

27. Recording QSOs 

The program has the possibility to record all QSOs made. With this feature it is possible to listen back 
to all QSOs made.  

 Select 'Record QSOs' under Config' to turn it on/off.  

 If you connect your microphone to your sound card's 'microphone in' jack and the radio audio 

out to the sound card 'line-in', the microphone can be used to record SSB messages on the fly 
and the line-in can be used to record QSOs or for RTTY without having to rewire anything. 
Switching can be done automatically, using the setup in the Audio tab for SSB recording and 
playback, and also works for CW QSO recording. Switching to RTTY may require using the 
windows volume control to select the input source for MMTTY.  

 Because the headphone level varies with the AF Gasin settintg of the radio, it is a good idea to 

use a fixed audio source from the radio, such as a "Line Out" or "Patch" output. There are 
some nice programs which can set your audio levels and remember the settings the next time 
you need them. See the Links chapter.  

 You probably want to record not only the station you work but also your own audio/sidetone. 

Check how your radio handles monitor audio.  

 A recording for a new QSO will start as soon as the QSO before has been logged. In S&P mode 

this will mean that any fills or corrections after you send your exchange and log the QSO will 
not be recorded.  

 The Audio tab in the Configurer sets the maximum length of the QSO recording, in seconds 
before the QSO is logged.  

 Each qso will become a separate recording (.wav file). The .wav file is named: '<Callsign> 
<Date> - <Time>.wav.' Example: "N1MM 10-26-03 - 22 47 45.wav"  

http://n1mm.hamdocs.com/tiki-index.php?page=Links#N1MM_Logger_Documentation


 The .wav files (recordings) are stored in a directory under the program directory, named after 

the selected contest. So when selecting CQWWCW the directory will be named CQWWCW. E.g. 
C:\Program Files\N1MM Logger\CQWWCW\....  

 .wav files can be played from within the program by right clicking on the QSO in the 'Log 
Window' and selecting 'Play contact'. Pressing Escape stops playback of recorded contacts.  

 These .wav files can of course also be played outside the program with any other media player 
on your computer which supports .wav files.  

 Recording uses about 1 GB per 24 hours (40-50 MB per hour) when 8 bits, 11025 Hz, and 1 

recording channel are selected on the Audio tab. .wav files are inherently limited to 2 GB total 
length.  

 Recording is stopped when there is less than 40 MB space free on the current drive.  

 

Soundcard Settings in Configurer 

The Configurer offers a choice of parameters, not all of which your sound card may support. 16 bit, 

11025 Hz is generally a safe choice for all cards. 

.  

 

1.9.4 The Most Frequently Asked Questions 

 1.9.4 The Most Frequently Asked Questions  

o 1. Installation and Updating  
o 2. Operating  
o 3. Interfacing  
o 4. Other  

We have tried to pull together here the most frequently asked questions. As issues come and go, we 
anticipate changing this section frequently, so if it comes up in a search of the web site, it could be 
worthwhile to check here first. Each answer also contains a link or links to the manual sections 

that address the issue in much more detail. The MFAQ is not intended as a substitute for the 
manual.  

1. Installation and Updating 

Q. I just downloaded the latest update and my virus software told me that it is infected. Is this true?  
A. No. Software that accesses the outside world (DX clusters, the N1MM web site, contest sponsors' 
rules) is frequently mis-identified by anti-virus software. Depending on which one you have, you may 
have to disable it, or simply tell it that the program is OK, but there's no way that N1MM Logger is 
infected.  

Q. I just installed the program for the first time, and it won't start. Why?  
A. Did you install the Latest Update after you installed the Base Install? Both are necessary. Did you 
install into a directory outside of C:\program files, as is recommended? Under Windows Vista and 
later, Windows does not want to allow writing to a directory under Program Files, which can make it 

difficult to configure a new installation.  

Q. I haven't updated in a while. Do I need to apply each update in order? If I apply the latest one, and 
it doesn't work for some reason, can I go back?  

A. If your current version dates from 2011 forward, you can simply download and install the latest 
update. If not, you will need to redo the Base Install and then install ONLY the latest update. You can 
generally revert to a recent update from the latest one without any problem. In fact, this is the 
recommended procedure if you run into a problem, since you may be able to pinpoint exactly which 
update introduced it.  

http://n1mm.hamdocs.com/tiki-index.php?page=Installing+the+Software&structure=N1MM+Logger+Documentation#Subsequent_Installation_of_the_Latest_Update_of_the_Software
http://n1mm.hamdocs.com/tiki-index.php?page=Installing+the+Software#First-Time_Installation_Instructions


Q. Shouldn't I install a .0 version (like 12.0.0)? Aren't the .n versions (e.g.,12.11.3 ) less reliable? 

What if the latest one has a bug I can't live with?  
A. Each new version builds on the one before, so there is no benefit to installing or keeping an older 
one. If the new release has a bug that you can't live with, and you need a fix before the following 

week, you can easily reinstall the last previous version. There is nothing special about .0 versions. 
They are just the first update of that month.  

2. Operating 

Q. The program won't let me log a contact. It keeps insisting that something is wrong with the 
exchange. What can I do?  
A. Ctrl+Alt+Enter will force logging any contact, and open a note window, where you can put 
something to remind you to fix the QSO after the contest is over, when you've discovered what was 
wrong.  

Q. Why doesn't F1 send my call properly in S&P mode? I can program it into the key, but when I use it 

the program switches to Run mode and I get crossed up.  
A. In N1MM Logger the F1 key has special attributes; in particular it automatically switches from S&P 

to Run mode, which make it problematic to use it, as some are used to doing, for your own callsign. 
F4 is customarily used for this in N1MM Logger. Note that if you use ESM (Enter Sends Messages), 
then in S&P mode the program will send your callsign (F4) when you press <Enter>; in Run mode it 
sends your CQ message, which is stored in F1.  

Q. I see spots coming in on the Packet/Telnet window, but they aren't appearing on the Bandmap or 
in the Available Mults and Qs window. What to do?  
A. On the Packet/Telnet Window's right-click menu, there is a "Why don't I see Spots?" selection. 
Choose it, then follow its suggestions and set up the Packet Filters options, which control which spots 
are passed to the Bandmap and Available windows. You must select at least one frequency range (HF, 
WARC, VHF) option or nothing will go through.  

Q. I've lost my Bandmap window (or Check, or Available Mults & Qs, or ...). How do I get it back?  

A. Most likely, it is invisible because its saved location is outside the dimensions of your screen. For 
windows that are part of the N1MM Logger itself, there is a Find All Windows command on the Config 
menu. Click on it and all windows will be moved within the boundaries of an 800 x 600 screen. If you 

still do not see the missing window, it may have been closed; find it on the Window menu, and click to 
open it again.  
There are two special cases:  
1. Grayline: go to the GrayLine subdirectory in the install directory and edit QTH.txt. Change the last 
two lines to 0 (zero) to bring the window to the top left corner.  
2. Rotor: Edit N1MM Rotor.ini and change Top & Left to 0 (zero) to bring the window to the top left 
corner.  

Q. I know that TO7M is in Martinique, but the program says otherwise. How do I fix this?  
A. Callsigns are identified by country files, which are produced and updated by AD1C. You probably 

need to update your wl_cty.dat file from his website, and then load it into your database. If you run 

into this problem during a contest, your best move is to log it and go on, placing a note in the log with 
Ctl+N to remind yourself to fix the log before you submit it. After you load the wl_cty.dat with the 
corrected country data, run Tools > Rescore Current Contest to update your Score Summary and 
multiplier counts.  

Q. When I enter my callsign in the Entry Window, the Check Window says "Unique". Why?  
A. The program checks entered callsigns against a master.dta file, and that message means that the 
callsign was not found. These files are prepared and updated by WA1Z, based on people's past contest 

logs. Check the Super Check Partial website  for the latest version and download it into your N1MM 

Logger program directory. These do not need to be loaded into your database; you specify which file 

http://n1mm.hamdocs.com/tiki-index.php?page=ESM+%28Enter+Sends+Messages%29&structure=N1MM+Logger+Documentation
http://n1mm.hamdocs.com/tiki-index.php?page=Packet+and+Telnet+Window#Right_Click_Menu
http://n1mm.hamdocs.com/tiki-index.php?page=Entry+Window#Config_Menu_Selections
http://n1mm.hamdocs.com/tiki-index.php?page=Grayline+Program
http://n1mm.hamdocs.com/tiki-index.php?page=Rotator+Control
http://n1mm.hamdocs.com/tiki-index.php?page=Entry+Window#Tools_Menu_Selections
http://n1mm.hamdocs.com/tiki-index.php?page=Check+Window
http://www.supercheckpartial.com/


to use under the Associated Files tab in the Contest Setup dialog. If you have the latest version and 
your call doesn't appear, you just need to be more active in contests.  

3. Interfacing 

Q. PTT or CW isn't working properly. Why not?  
A. The program has a lot of different ways to "key" PTT, to accommodate the wide variety of radios 
and operator preferences. From within the program, you can assert PTT (another, more accurate verb) 
by the RTS or DTR pins of a serial port, via pins on a parallel port, or through serial radio control, for 

radios that can do that. CW can be sent through a serial or a parallel port, or by the use of Winkey. 
Here are some things to check:  
1. Make sure you have only one PTT and one CW method set for each radio. The program will always 
use the first such method it finds, reading down through the list of serial and parallel ports (COM 1-8 
and LPT 1-3) that have the "Other" checkbox checked, so if you have set more than one, 
unpredictable things may happen.  

2. If you are using a Winkey, and you have it configured to control PTT (yet another way to say it), it 

will do so for stored messages on all modes, not just CW. If you want something else, the easiest 
thing is simply to pull the PTT line out of the PTT jack on the back of the Winkey to disable it.  

Q. My Icom radio gets out of sync with the program on things like split frequencies, and I wind up 
spotting the wrong frequency sometimes, which is embarrassing. What is wrong?  
A. Icom radios only send the frequency of the active (selected) VFO to the program. If you set split 
frequency operation on the radio, the program is not informed, and so it will spot your transmit 
frequency instead of the received frequency as it should. The solution is simple - use the keyboard to 
enter the split receive frequency (Alt+F7, frequency or split, e.g. 7067 or +5, Enter) .  

Q. My CW seems to stutter sometimes. Why?  
A. N1MM Logger's serial and parallel port CW options are a simple and easy way to generate CW, but 

if your computer is slow, you may find the CW is not always smooth, particularly when receiving spots 
from a Telnet cluster in a busy contest. If this happens with serial keying, try using a parallel port if 
you have one. If you don't, or if you want to put an end to CW issues once and for all, the answer is 

K1EL's Winkeyer USB, which handles CW and all-mode PTT by offloading these functions from the 
computer entirely. It is also an excellent stand-alone keyer with 4 built-in memories.  

Q. I can't find a contest that I want to operate in N1MM Logger.  
A. Over 250 contests and QSO parties are supported directly by N1MM Logger. You can look them up 
here. In addition, over 100 contests have been defined using our User Defined Contest editor, 
developed by NA3M. To use one of these, you will need to copy the relevant UDC file from this file 

gallery on the web site into the UDC folder in the program directory, and then re-start the program - 
the UDC will now show up on the list of possible contests in the Contest Setup Dialog. A final option, if 
you don't find your contest in either place, is to write your own UDC. It's not terribly hard if you 
thoroughly understand the contest's rules.  

Q. What is the difference between SO2R and SO2V?  
A. SO2R is the "single operator two radios" mode of contesting, where you control two radios from one 
logging program. SO2V (single operator two VFOs) is a technique for using two VFOs on a single radio 
to approximate the benefit of SO2R. Because you cannot listen on the same radio you are transmitting 

on, it will never be as flexible as SO2R, but you can use the second VFO to work stations S&P while 

continuing to run on the first VFO, particularly when things are slow. A fuller explanation is found 
here.  

4. Other 

Q. I'm having trouble importing an ADIF file. Some of the information seems to be missing or in the 
wrong place.  
A. ADIF implementations vary widely, and it is quite common for an ADIF file produced by another 

http://n1mm.hamdocs.com/tiki-index.php?page=The+Contest+Setup+Dialog&structure=N1MM+Logger+Documentation#Contest-Specific_Information
http://n1mm.hamdocs.com/tiki-index.php?page=Supported+Radios#Icom
http://n1mm.hamdocs.com/tiki-index.php?page=Supported+Contests&structure=N1MM+Logger+Documentation
http://n1mm.hamdocs.com/tiki-index.php?page=The+User+Defined+Contest+Editor
http://n1mm.hamdocs.com/tiki-list_file_gallery.php?galleryId=18
http://n1mm.hamdocs.com/tiki-list_file_gallery.php?galleryId=18
http://n1mm.hamdocs.com/tiki-index.php?page=Single+Operator+Two+Radio+Operation+%28SO2R%29&structure=N1MM+Logger+Documentation
http://n1mm.hamdocs.com/tiki-index.php?page=Single+Operator+Two+VFO+Operation+%28SO2V%29&structure=N1MM+Logger+Documentation
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logging program to contain ADIF "tags" that N1MM Logger does not recognize. Here's how we suggest 

proceeding, to avoid these problems:  
1. Create an instance of the contest you want to import in your current N1MM Logger database.  
2. Log a "dummy" QSO. If there are different types of QSOs, e.g. different exchanges from W/VE vs. 

DX stations, log at least one QSO of each type.  
3. Export an ADIF file.  
4. Compare the ADIF file produced by N1MM Logger with the one you want to import. Each data item 
in an ADIF file is preceded by a "tag"Â• including a number denoting the length of the data item. 
Here are some examples, part of a QSO record from a general logging program:  
<TIME_ON:6>003039 <CALL:6>YC6JRT <MODE:3>SSB <BAND:3>10m <RST_SENT:2>59 
<RST_RCVD:2>59 <CQZ:2>28  

If the "tag" is different than N1MM Logger uses for the same content, use a word processor or other 
editor to change it as needed.  
5. Make sure the ADIF file you want to import contains a field tagged with the CONTEST_ID tag, and 
with the same contest name as in the ADIF file exported from N1MM Logger.  
6.Then go ahead and do the import, and everything should be fine.  
You can reverse this process to export an ADIF file, for example to a general logging program.  

Q. I want to use N1MM Logger as my general logging program, but I can't find out how to track my 
DXCC, or whether I have sent or received QSLs. Why not?  

A. N1MM Logger is a contest logger. While it has "DX" and "DX Serial" generic "contests" that can be 
used for general logging, it does not have many of the features needed in a general logging program. 
The best solution is to export your contest QSOs from N1MM, using ADIF, and import them into one of 
the many excellent general loggers that are available.  

Q. I got a cryptic error message. What do I do?  
A. Make a detailed note of the error message number AND message as accurately as possible. We 
need that information, together with the sequence of program operations that resulted in the error, in 
order to trouble-shoot and solve the problem.  

Q. I posted a problem on the reflector, but it never got fixed. Should I do something else?  
A. Yes. Go to the web site and file a Bug Report. Same goes for Feature Requests. While we try to 

respond to every problem that is reported on the reflector, the structure of these two systems helps 
us keep track of what's been fixed and what still needs to be.  

 

1.9.5 Troubleshooting 

 1.9.5 Troubleshooting  

o 1. Get Current  
o 2. Try Simplifying Your Configuration  
o 3. Search the Manual - some tips  
o 4. Looking for Help on the Reflector  

o 5. Asking for Help from the N1MM Team  
o 6. Trouble with RFI?  

 6.1. Resources  
 6.1.1. Electronic keyer RFI (from Chuck Counselman, W1HIS)  

o 7. Trouble with Keying Delays or Radio Timeouts  

The object of this page is to suggest how to proceed when something goes wrong. If you take these 
measures before posting a query on the reflector, you will greatly enhance your chances of getting 
good, solid, usable advice the first time around.  

1. Get Current 

http://n1mm.hamdocs.com/tiki-index.php?page=Error+Messages
http://n1mm.hamdocs.com/tiki-index.php?page=TRACKER+-+N1MM+Logger+Bug+Report
http://n1mm.hamdocs.com/tiki-index.php?page=TRACKER+-+N1MM+Logger+Feature+Request


Make sure you are running a recent version - no more than one or two behind. This is absolutely 

necessary because of the rapid evolution of the program, with typically 50 or so versions released 
each year. If you aren't running a recent version, update and see if the problem goes away - it could 
be something that was noticed and fixed while you were "away."  

Every year or so, typically, Tom (N1MM) publishes a new "Full Install" version of the program, which 
contains all the files you will need to run the program. Subsequent updates contain only those files 

that have changed, so simply downloading and installing the most recent version won't probably be 
enough unless you have first downloaded and installed the Full Install on which it is based. You do not 
have to install every intermediate update; the updates are cumulative.  

2. Try Simplifying Your Configuration 

 
Problems with the program often arise as the result of changes inadvertently made to the overall 
configuration of the program or corruption of the database you were using the last time the program 
was open, so a first step is to eliminate those two possibilities.  

First, rename your N1MM Logger.ini file so that the program will not recognize it - N1MM Logger.old is 
good. Try to restart the program. If it starts, though in very simplified form (one Entry window, etc.), 
then you know the problem was somewhere in your configuration, as stored in the .ini file. Then you 
can add back your personal configuration choices, one at a time. Start with radio control ports, then 

add PTT and CW options. Finally, set up your general options in the Configurer, and in the various 
specialized sub-menus that you use.  

If the program still won't run, then leave the simplified configuration in place and try renaming your 
database(s) or moving them to another directory. It should then start up and create a new empty 
database (at least, with no QSOs in it.). If it doesn't start up then, you should probably consider 
yourself cursed, and take up a new hobby.  

No, seriously, if the problem does seem to be in the database(s), there are a couple of options on the 

File menu in the entry Window, including a link to a stand-alone Microsoft utility that you can 
download to repair a corrupted database.  

If it still won't start after all that, or if the function you're having trouble with still won't work, now and 
only now try a reinstallation. A corrupted installation is rarely to blame for the problems people have, 
but recently a lot of folks have had trouble because of missing program files. Typically, this is caused 
by not installing version 10.0.0 before trying to install and run version 10.x.x Even if you think you've 
done this correctly, it may be worth the few minutes necessary to reinstall.  

If you feel you need to reinstall, take an extra minute and uninstall your current version from the 

control panel. This is normally unnecessary, but recently there have been a case or two where the 
uninstallation was necessary to fix persistent problems that did not respond to any normal 
troubleshooting methods.  

 

Where is the program installed? 

For version 9 and before, the default installation location was in C:\Program Files\N1MM Logger. 
Because this caused inconvenience for users of Vista and Windows 7, beginning with Version 10, the 
default location is C:\N1MM Logger.  
If you are making a first-time installation of the Version 10 Full Install, the installer will automatically 
choose this location. Thereafter, the update installer should point to the same place. However, some 

experienced users have chosen to continue to install to Program Files, and a few of them have 
reported that the update installer insists on pointing to C:\. As you can imagine, putting the Full Install 
in one place and updates in another can cause all sorts of problems. It's worth a double-check.  



3. Search the Manual - some tips 

 

Now that the manual is on the website in wiki format here , we are working hard to keep it up to 
date and to fix things that may have gotten broken along the way. You can help by letting us know 

when you notice things that should be changed. Drop a note to n4zr@contesting.com or k8ut@arrl.net 
unless you think that the subject would benefit from others' input, in which case, by all means, use 

the reflector .  

So, how best to use the manual for troubleshooting? We recommend using the search function on the 
web page. This is still evolving, but you'll find the latest information on using it in this section of the 
Website User Manual. These days, the Advanced Search (under "Website") is far better than the basic 
search.  

Once you've opened a page, though, you may discover that the topic you want is nowhere to be seen. 

Don't despair, just hit Ctrl+F to open your browser's search routine, and enter your search phrase 
there. This is necessary because some of the pages in the manual are very long, and your search topic 
may not appear in the first screenful.  

If the program is so badly broken that you can't do a Google search from there, just open the manual

.  

4. Looking for Help on the Reflector 

 
OK, so you're really stuck. You have over 3,000 fellow users out there willing to help. You can make it 
more likely to pay off quickly if you follow this checklist for information you provide in your first 
message:  

 N1MM program version  

 Operating system  

 Relevant interfacing information  
o For radio control, whether USB or hardware serial port, and what radio  

o For CW problems, indicate whether you are using serial, parallel or other interface 
(Winkeyer, MicroHAM, etc.)  

o For voice message problems, what interface to the radio you're using  

 Symptoms  
o Include any error messages you received, and be sure to quote them in full  

 What you have already tried  

5. Asking for Help from the N1MM Team 

OK, so you've asked for help on the reflector, and your problem persists. Chances are one of the 
development team has already contacted you and asked for more information. Here's what you can do 

to help him help you (I apologize in advance if this is elementary to many people - not everyone who 
uses N1MM Logger is a computer jock, or indeed other than an appliance user. That's OK, but you're 
our particular audience for this note, to help you do things to help us help you)  

 Make sure that your computer operating system is showing you the complete filenames, 

including the extension. Windows default this off, for some reason. Turn it on, because you'll 
need it to find the files we're going to ask you for. In Windows 7, you can find Folder Options 
from the search box just above the Start button. In Windows XP, the same choices are found 
in the top frame of Windows Explorer.  

http://n1mm.hamdocs.com/
http://groups.yahoo.com/group/n1mmlogger
http://n1mm.hamdocs.com/tiki-index.php?page=Search+the+N1MM+Logger+Website
http://n1mm.hamdocs.com/tiki-index.php?page=Search+the+N1MM+Logger+Website
http://n1mm.hamdocs.com/
http://n1mm.hamdocs.com/


 Find the N1MM Logger.ini file in your program directory - the one where you installed N1MM 

Logger.  

 Then find the current database file - the suffix will be .mdb, and it should be the one you were 
last using when your problem occurred. If you have just started, chances are it will be 
ham.mdb.  

o Note - in addition to the database file, N1MM also creates what are known as 
transaction files - text files titled with the name of the database in use at the time, 
and the name of the contest. They look like this: 2010-2012.mdb - CQWPXCW - 
2012-04-14 - 392.TRN. __Don't send us this file - it is useless for trouble-shooting.  

o If you aren't sure, start N1MM Logger and look in the top bar of the Log window to find 
the database filename. If you can't start the program, right click on each of the .mdb 
files in turn, and check the "modified" date. The most recent one is ... no surprise here 

... the one we want.  

 Send both of these files by direct e-mail to the team member offering help. You can't attach 
files to messages sent to the reflector. If you're initiating contact, you can send the e-mail to 
n4zr@contesting.com, and he will forward it as needed.  

6. Trouble with RFI? 

 
Many of the quirky problems people experience are due to RFI (RF interference) from their own 

transmitters. If the symptoms become less serious, or go away altogether when you turn down the 
power or change bands, or both, then you probably need to look at filtering common mode currents 
on some or all of the cables in your station setup.  

6.1. Resources 

Chuck Counselman, W1HIS, has published an excellent tutorial on common mode chokes for RFI 

control and even for reducing your local noise level, The article can be found here .  

Jim Brown, K9YC, has also written an excellent tutorial, which can be found here .  

With these two references in hand, you will be well prepared for trouble-shooting RFI when it occurs 
(not if).  

An often overlooked problem is RFI affecting an electronic keyer. Chuck Counselman's article on this 
subject, reproduced below with his permission, also makes several excellent points about RFI 
suppression in general:  

6.1.1. Electronic keyer RFI (from Chuck Counselman, W1HIS) 

RFI trouble with USB-connected products such as computer keyboards is well known. Less well known 
is the extent of RFI trouble with rig-interface and CW-keyer products such as as microHAM's 

microKeyer, microKeyer II, etc. that utilize K1EL WinKeyer ICs. K1EL's own WKUSB product is also 
quite vulnerable to RFI.  

In the case of a keyer, not only the USB interface but also the paddle interface is vulnerable to RFI.  

Most hams, myself included, have underestimated these products' sensitivities to RFI. We have made 

the mistake of putting too little ferrite on the cables connected to these products, or failing to put 
ferrite on all the cables connected to them, and erroneously thinking we have eliminated our RFI 
problems just because we no longer experience RFI symptoms when we operate on our usual band(s). 
Then when a higher-frequency band is open, or when the beam is pointed at the shack, all h*ll breaks 
loose.  

http://www.yccc.org/Articles/W1HIS/CommonModeChokesW1HIS2006Apr06.pdf
http://www.audiosystemsgroup.com/RFI-Ham.pdf
http://www.k1el.com/


RFI trouble recurs also when we rearrange, add, or even disconnect a cable in our shacks. Every cable 

acts as an antenna and has discrete resonances. All the cables behind or under your operating desk 
are coupled to one another, and this coupling affects their resonant frequencies and modes. When I 
disconnected both ends of a telephone extension cable behind my desk, the K1EL WinKeyer IC in my 
microHAM microKeyer began misbehaving when I transmitted on the 17-m band.  

From my own and others' mistakes I have learned to avoid recurring trouble by installing enough 

ferrite the first time. "Enough" means at least 1000 ohms of common-mode choking resistance on 
_every_ cable connected to a vulnerable device. Not only the USB cable, but also the cables for 12-
VDC power, paddle, microphone, earphones, footswitch, audio to/from computer and radio, CW keying 
to the TX, "PTT" or T/R-switching to transceiver and to amp., data-comm. to/from transceiver — every 
one. You cannot anticipate which cable will be "hot" with RF when you transmit on a particular 
frequency. If you determine which cable is hot today, then a different cable will be hot tomorrow after 
you change something. You will change something.  

I thought that the level of RF in my shack was trivial because, if I transmitted full power on any band, 

the RF field-strength shown by my laboratory-grade meter increased by less than ten percent above 

its normal background level due to AM broadcast stations more than a mile away. Wrong! My 
microHAM microKeyer was insensitive to the AM broadcast signals, but it was disabled by the 
relatively weak signal from my 18-MHz transmitter.  
-Chuck Counselman, W1HIS  

7. Trouble with Keying Delays or Radio Timeouts 

 For internally generated CW (as opposed to Winkeyer or other interfaces using the Winkey 
chip) , don't worry about the 100% CPU utilization for CWIF.exe that you will see in Task 

Manager. It does not mean that other services/processes are not able to run.  

 Verify that the radio timeout is set to 15 seconds or greater.  

 All recent vintage radio interfaces are tested at baud rates of 19200 and 38400. Do not 

assume that slower baud rates will produce better results. If your radio supports 9600 baud 
and lower data rates, use 9600 baud.  

 Verify that multi-user mode is not enabled for single computer configurations.  

 Close the Digital Interface when operating CW/SSB.  

 On multi-core computers, if WinKey is configured, do not use internally generated CW (COM or 

LPT CW). Use the WinKey to send CW. Multi-core computers that have WinKey configured will 
process spots while the CW is sending.  

 If you are using Telnet, try setting the spot timeout to a low value (10 minutes).  

 Compact the database (File > Copy and Compact Database). Then restart the program and 
open the compacted database. Computers with limited disk cache or slower hardware 
interfaces may be susceptible to fragmented databases. Compacting the database will 
unfragment the database.  

 Close all possible programs. Don't place them on the task bar.  

 Close all possible N1MM Logger windows. Don't place them on the task bar.  

 If using any high volume spot source (RBN, skimmer, combined spot sources, etc), delete all 
spots (right click in the Bandmap) to see if this has an impact.  

 Turn off anti-virus or computer security file scanning. Many users have found that the free 

Microsoft Security Essentials doesn't seem to use many resources and you can set the CPU 
limit in percentage for scanning activities.  

 Microsoft Recovery Console has caused sending delays with internally generated CW on single 

core 2.8 GHz CPU computers. Recovery Console usually displays text on the screen after the 
BIOS boot screen and before the Windows splash screen. Google for the steps to un-install 
Recover Console.  

 
There haven't been any reports of issues with WinKey generated CW.  



Intermittent delays may be caused by any of the following:  

 Automatic Windows updates. Change the Windows setting temporarily during contests so 
Windows doesn't check for updates, install them, or force a reboot.  

 Other program update checking, downloads, and installs - again, temporarily disable them 

during contests  

 Anti-virus or computer security file scanning.  

 Unreachable time server for Windows or separate time-setting programs. Solve the problem, 
or disable the time updates for contests.  

 Windows scanning/searching/connecting to wireless networks, printer, or other wireless 

devices that may be unreachable or disconnect/connect due to RF.  

 Transmitter RF causing wired and wireless networks to disconnect.  

 Some computers may be susceptible to sending delays if the amount of free ram is not great 
enough for all active program temporary storage. Be aware that some computers use system 
RAM for video display and reduce the memory available for Windows by 256Meg. The impacts 
of disk paging is dependent on the amount of data and speed of all hardware interfaces 

involved. The hard disk activity LED may be a good indicator of how often and the duration of 
the disk activity. The Task Manager, Performance tab displays Available Free Memory.  

 
When all of the above actions have failed to produce results:  

 Some users have found success by rename the N1MM Logger.ini file. Starting the program will 

build a new file with defaults.  

 Others have had success with renaming the program directory and re-install the software (Full 

Install, reboot, Latest Update). Do not use any files from the old program directory until you 
have completely verified that there was no change in the program delay.  

 Open Task Manager and look at the number running processes after a fresh reboot, no 

programs started. WinXp processes greater than 40 or Win7 greater than 55 may be an 
indication that unexpected or unnecessary programs are running. There are many websites 
that provide instructions for eliminating unnecessary programs at program start.  

 For advanced computer users: Make a restore point and use HiJackThis to scan your computer 

to display every item that is loaded when the computer starts. Account for each item, Google 
unknown ID's to see if it's an unwelcome guest.  

 For advanced computer users: Measure your computer's DPC latency when N1MM Logger is 
running. It is well known that some drivers misbehave and add significant delays to the PC 
operation. The Flex folks have found that some motherboard designs are simply not 

acceptable for low latency tasks. The URL for a DPC latency measuring programs is here .  

 

http://www.thesycon.de/eng/latency_check.shtml
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